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WARNING
•	 To reduce the risk of fire or electric shock, do 

not expose this appliance to rain or moisture.
•	 This product contains chemicals known to 

the State of California to cause cancer and 
reproductive toxicity.

FCC NOTE (for U.S.A)
This equipment has been tested and found to 
comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC rules. These limits are 
designed to provide reasonable protection against 
harmful interference in a residential installation. This 
equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful 
interference to radio or television reception, which can 
be determined by turning the equipment off and on.
The user is encouraged to try to correct the 
interference by one or more of the following measures.
•	 Reorient or relocate the receiving antenna.
•	 Increase the separation between the equipment 

and receiver.
•	 Connect this equipment into an outlet on a 

circuit different from that to which the receiver is 
connected.

•	 Consult the dealer or an experienced radio/TV 
technician for help.

•	 This class B digital product meets all 
requirements of the Canadian Interference - 
Causing Equipment Regulations.

Note to CATV system installer
This reminder is provided to call CATV system 
installer's attention to Article 820-40 of the 
National Electrical Code (Section 54 of Canadian 
Electrical Code, Part I) that provides guidelines 
for proper grounding and, in particular, specifies 
that the cable ground shall be connected to the 
grounding system of the building as close to the 
point of cable entry as practical.

Warning

TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT REMOVE THE COVER (OR BACK).
NO USER-SERVICEABLE PARTS ARE INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

CAUTION
RISK OF ELECTRIC SHOCK

DO NOT OPEN

The lighting flash and Arrowhead within the 
triangle is a warning sign alerting you to 
dangerous voltage inside the product.

CAUTION: TO REDUCE THE RISK OF ELECTRIC 
SHOCK, DO NOT REMOVE COVER (OR BACK). 
NO USER SERVICEABLE PARTS INSIDE. REFER 
SERVICING TO QUALIFIED SERVICE PERSONNEL.

The exclamation point within the triangle 
is a warning sign alerting you to important 
instructions accompanying the product.

CLASS 1 LASER product
This Compact Disc player is classified as a CLASS 
1 LASER product. Use of controls, adjustments 
or performance of procedures other than those 
specified herein may result in hazardous radiation 
exposure.
Complies with 21CFR 1040.10 except for 
deviations pursuant to Laser Notice No. 50, dated 
June 24, 2007.
DANGER :
•	 VISIBLE AND INVISIBLE LASER RADIATION 

WHEN OPEN. AVOID DIRECT EXPOSURE TO 
BEAM. (FDA 21 CFR)

CAUTION :
•	 CLASS 3B VISIBLE AND INVISIBLE LASER 

RADIATION WHEN OPEN. AVOID EXPOSURE 
TO THE BEAM. (IEC 60825-1)

•	 THIS product UTILIZES A LASER. 
USE OF CONTROLS OR ADJUSTMENTS 
OR PERFORMANCE OF PROCEDURES 
OTHER THAN THOSE SPECIFIED HEREIN 
MAY RESULT IN HAZARDOUS RADIATION 
EXPOSURE. DO NOT OPEN COVER AND DO 
NOT REPAIR YOURSELF. REFER SERVICING 
TO QUALIFIED PERSONNEL.

CLASS 1	 LASER PRODUCT
KLASSE 1	 LASER PRODUKT 
LUOKAN 1	 LASER LAITE
KLASS 1 	 LASER APPARAT
PRODUCTO	 LÁSER CLASE 1

|| NOTEs |
\\ If the Region number of a Blu-ray Disc/DVDs does not 

correspond to the Region number of this player, the player 
cannot play the disc.
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Precautions

Important Safety Instructions
Read these operating instructions carefully before 
using the unit. Follow all the safety instructions 
listed below. 
Keep these operating instructions handy for future 
reference.
1.	 Read these instructions.
2.	 Keep these instructions.
3.	 Heed all warnings.
4.	 Follow all instructions.
5.	 Do not use this apparatus near water.
6.	 Clean only with a dry cloth.
7.	 Do not block any ventilation openings. Install 

in accordance with the manufacturer's 
instructions.

8.	 Do not install near any heat sources such 
as radiators, heat registers, stoves, or other 
apparatus (including AV receivers) that 
produce heat.

9.	 Do not defeat the safety purpose of the 
polarized or grounding-type plug. A polarized 
plug has two blades with one wider than the 
other. A grounding type plug has two blades 
and a third grounding prong. The wide blade 
or the third prong are provided for your safety. 
If the provided plug does not fit into your 
outlet, consult an electrician for replacement 
of the obsolete outlet.

10.	 Protect the power cord from being walked on 
or pinched particularly at plugs, convenience 
receptacles, and the point where it exits the 
apparatus.

11.	 Only use attachments/accessories specified 
by the manufacturer.

12.	 Use only with the cart, 
stand, tripod, bracket, 
or table specified by the 
manufacturer, or sold with 
the apparatus. When a cart 
is used, use caution when 
moving the cart/apparatus combination to 
avoid injury from tip-over.

13.	 Unplug this apparatus during lightning storms 
or when unused for long periods of time.

14.	 Refer all servicing to qualified service 
personnel. Servicing is required when the 
apparatus has been damaged in any way, 
such as when the power-supply cord or plug 
is damaged, liquid has been spilled or objects 
have fallen into the apparatus, the apparatus 
has been exposed to rain or moisture, does 
not operate normally, or has been dropped.

Disc Storage & Management

•	 Holding Discs
-- Fingerprints or scratches on 

a disc may reduce sound and 
picture quality or cause skipping.

-- Avoid touching the surface of a disc where 
data has been recorded.

-- Hold the disc by the edges so that fingerprints 
will not get on the surface.

-- Do not stick paper or tape on the disc.
•	 Cleaning Discs

-- If you get fingerprints or dirt on a 
disc, clean it with a mild detergent 
diluted in water and wipe with a 
soft cloth. 

-- When cleaning, wipe gently from the inside to 
the outside of the disc.

•	 Disc Storage
`` Do not keep in direct sunlight.
`` Keep in a cool ventilated area.
`` Keep in a clean protection jacket and store 
vertically.

Handling Cautions

•	 Do not expose this apparatus to dripping or 
splashing. Do not put objects filled with liquids, 
such as vases on the apparatus.

•	 To turn this apparatus off completely, you must 
pull the power plug out of the wall socket. 
Consequently, the power plug must be easily 
and readily accessible at all times. 
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•	 Do not plug multiple electric devices into the 

same wall socket. Overloading a socket can 
cause it to overheat, resulting in a fire.

•	 Before connecting other components to this 
player, be sure to turn them off.

•	 If you move your player suddenly from a cold 
place to a warm place, condensation may occur 
on the operating parts and lens and cause 
abnormal disc playback. If this occurs, unplug 
the player, wait for two hours, and then connect 
the plug to the power outlet.  
Then, insert the disc, and try to play back again.

•	 If the product makes an abnormal noise or 
produces a burning smell or smoke, turn off 
the power switch immediately and disconnect 
the power plug from the wall outlet. Then, 
contact the nearest customer service center for 
technical assistance. Do not use the product. 
Using the product as it is may cause a fire or an 
electric shock. 

|| CAUTIONS |
\\ Do not dispose of batteries in a fire.
\\ Do not short circuit, disassemble or overheat the 

batteries.
\\ Danger of explosion if battery is incorrectly replaced. 

Replace only with the same or equivalent type.

Using the 3D function

IMPORTANT HEALTH AND SAFETY 
INFORMATION FOR 3D PICTURES.  
Read and understand the following safety 
information before using the 3D function. 
•	 Some viewers may experience discomfort while 

viewing 3D TV such as dizziness, nausea, and 
headaches.  
If you experience any such symptom, stop 
viewing 3D TV, remove the 3D Active Glasses, 
and rest.

•	 Watching 3D images for an extended period of 
time may cause eye strain. If you feel eye strain, 
stop viewing 3D TV, remove your 3D Active 
Glasses, and rest.

•	 A responsible adult should frequently check on 
children who are using the 3D function.  
If there are any reports of tired eyes, headaches, 
dizziness, or nausea, have the child stop viewing 
3D TV and rest.

•	 Do not use the 3D Active Glasses for other 
purposes (Such as general eyeglasses, 
sunglasses, protective goggles, etc.).

•	 Do not use the 3D function or 3D Active Glasses 
while walking or moving around. Using the 3D 
function or 3D Active Glasses while moving 
around may cause you to bump into objects, 
trip, and/or fall, and cause serious injury.

•	 If you want to enjoy 3D content, connect a 3D 
device (3D compliant AV receiver or TV) to the 
player's HDMI OUT port using a high-speed 
HDMI cable. Put on 3D glasses before playing 
the 3D content.

•	 The player outputs 3D signals only through 
HDMI cable connected to the HDMI OUT port.

•	 As the video resolution in 3D play mode is fixed 
according to the resolution of the original 3D 
video, you can not change the resolution to your 
preference.

•	 Some functions such as BD Wise, screen size 
adjustment, and resolution adjustment may not 
operate properly in 3D play mode.

•	 You must use a high-speed HDMI cable for 
proper output of the 3D signal.

•	 Stay at least three times the width of the screen 
from the TV when watching 3D images. For 
example, if you have a 46-inch screen, stay 138 
inches (11.5 feet) from the screen.

•	 Place the 3D video screen at eye level for the 
best 3D picture.

•	 When the player is connected to some 3D 
devices, the 3D effect may not function properly.

•	 This player does not convert 2D content into 
3D.

•	 "Blu-ray 3D" and "Blu-ray 3D" logo are 
trademarks of the Blu-ray Disc Association.

Copyright

© 2013 Samsung Electronics Co.,Ltd.
All rights reserved; No part or whole of this user's 
manual may be reproduced or copied without the 
prior written permission of Samsung Electronics 
Co.,Ltd.
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Getting Started
Disc and Format Compatibility

Disc types and contents your player can play

Media Disc Type Details

VIDEO

Blu-ray Disc 
3D Blu-ray Disc BD-ROM or BD-RE/-R recorded in the BD-RE format.

DVD-VIDEO 
DVD-RW 
DVD-R 

DVD+RW 
DVD+R

DVD-VIDEO, recorded DVD+RW/DVD-RW(V)/DVD-R/+R that have been recorded and 
finalized, or a USB storage media containing MKV, MP4 contents.

MUSIC
CD-RW/-R,  
DVD-RW/-R, 

BD-RE/-R

Music recorded on CD-RW/-R, DVD-RW/-R, BD-RE/-R or a USB storage media 
containing MP3 or WMA contents.

PHOTO
CD-RW/-R,  
DVD-RW/-R, 

BD-RE/-R

Photos recorded on CD-RW/-R, DVD-RW/-R, BD-RE/-R or a USB storage media 
containing JPEG contents.

|| NOTEs |
\\ The player may not play certain CD-RW/-R and DVD-R because of the disc type or recording conditions.
\\ If a DVD-RW/-R has not been recorded properly in DVD video format, it will not be playable.
\\ Your player will not play content that has been recorded on a DVD-R at a bit-rate that exceeds 10 Mbps.
\\ Your player will not play content that has been recorded on a BD-R or USB device at a bitrate that exceeds 25 Mbps.
\\ Playback may not work for some types of discs, or when you use specific functions, such as angle change and aspect ratio 

adjustment. Information about the discs is written in detail on the disc box. Please refer to this if necessary.
\\ When you play a BD-J title, loading may take longer than a normal title or some functions may perform slowly.

Disc types your player cannot play

•	 HD DVD
•	 DVD-ROM/PD/ 

MV, etc

•	 DVD-RAM
•	 Super Audio CD  

(except CD layer)

•	 DVD-RW (VR mode)
•	 CVD/CD-ROM/CDV/

CD-G/CD-I/LD 
(CD-Gs play audio only, 
not graphics.)

•	 3.9 GB DVD-R for 
Authoring.
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Getting Started
Region Code
Both players and discs are coded by region. 
These regional codes must match for a disc to 
play. If the codes do not match, the disc will not 
play. 
The Region Number for this player is displayed on 
the rear panel of the player.

Disc Type Region 
Code Area

Blu-ray Disc

a
North America, Central America, 
South America, Korea, Japan, 
Taiwan, Hong Kong and South 
East Asia.

b
Europe, Greenland, French 
territories, Middle East, Africa, 
Australia and New Zealand.

c India, China, Russia, Central and 
South Asia.

DVD-VIDEO

1 The U.S., U.S. territories and 
Canada

2 Europe, Japan, the Middle East, 
Egypt, Africa, Greenland

3 Taiwan, Korea, the Philippines, 
Indonesia, Hong Kong

4
Mexico, South America, 
Central America, Australia, 
New Zealand, Pacific Islands, 
Caribbean

5 Russia, Eastern Europe, India, 
North Korea, Mongolia

6 China

Logos of Discs the player can play

Blu-ray Disc 3D Blu-ray Disc

BD-LIVE NTSC broadcast system in 
U.S.A, Canada, Korea, Japan
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Supported Formats

Video File Support

File Extension Container Video Codec Resolution Frame rate 
(fps) Bitrate (Mbps) Audio Codec

*.avi
*.mkv
*.asf

*.wmv
*.mp4
*.3gp
*.vro

*.mpg
*.mpeg

*.ts
*.tp
*.trp

*.mov
*.flv
*.vob
*.svi

*.m2ts
*.mts

AVI
MKV
ASF
MP4
3GP
MOV
FLV
VRO
VOB
PS
TS

SVAF

MPEG4 SP/ASP

1920x1080 
(WMV v7,v8, 

MSMPEG4 v3 : 
1280x720)

6~30 30

Dolby Digital
LPCM

ADPCM(IMA, MS)
AAC

HE-AAC
WMA

Dolby Digital Plus
MPEG(MP3)
DTS (Core)

H.264 BP/ 
MP/HP

Motion JPEG

Microsoft  
MPEG-4 v3

Window Media 
Video v7,v8,v9

MPEG2 

MPEG1

VP6 640x480 4

MVC 24/25/30 60

*.webm WebM VP8 1920x1080 6~30 20 Vorbis

`` Limitations
-- Even when the file is encoded by a supported codec listed above, a file might not be played if its 

content is defective or corrupted.
-- Normal playback is not guaranteed if the file’s container information is wrong or the file itself is 

corrupted.
-- Files having higher bit or frame rates than indicated in the table above may stutter when played back.
-- The Seek (Jump) function is not available if the file’s index table is damaged.
-- When you playback a file remotely through a network connection, video playback may stutter 

depending on the network speed.
-- Some USB/Digital camera devices may not be compatible with the product.
`` Video decoder
-- Supports up to H.264 Level 4.1. (Does not support FMO/ASO/RS)
-- Does not support VC1/AP/L4. 
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Getting Started
-- CODECs except for WMVv7, v8, MSMPEG4 v3, 

MVC, VP6 
1)	 Below 1280 x 720 : 60 frames max.
2)	 Above 1280 x 720 : 30 frames max.

-- Does not support GMC 2 or higher.
-- Supports SVAF (Top/Bottom, Side by Side).
-- Supports BD MVC Spec.
`` Audio decoder
-- Supports WMA 10 PRO (Up to 5.1).
-- Does not support WMA lossless audio.
-- Supports ADPCM IMA,MS.
-- Does not support ADPCM(A-Law, μ-Law).
-- Does not support QCELP/AMR NB/WB.
-- Supports vorbis (Up to 2ch).
-- Supports DD+ (Up to 7.1ch).

|| NOTEs |
\\ Playback of some MKV or MP4 file may not be supported 

depending on their video resolution and frame rate.

Supported Subtitle File Formats

Name File 
Extension

External

MPEG-4 Timed text .ttxt
SAMI .smi

SubRip .srt
SubViewer .sub
Micro DVD .sub or.txt

SubStation Alpha .ssa
Advanced SubStation 

Alpha .ass

Powerdivx .psb

Internal

Xsub AVI
SubStation Alpha MKV

Advanced SubStation 
Alpha MKV

SubRip MKV

MPEG-4 Timed text MP4

Music File Support

File 
Extension Type Codec Support Range

*.mp3 MPEG
MPEG1 
Audio 

Layer 3
-

*.m4a 
*.mpa 
*.aac

MPEG4 AAC -

*.flac FLAC FLAC Supports up to 2ch

*.ogg OGG Vorbis Supports up to 2ch

*.wma WMA WMA

Supports WMA 10 
Pro (Up to 5.1).

Does not support 
WMA lossless audio.
Supports up to M2 

profile.
Does not support  

LBR mode.

*.wav wav wav -

*.mid 
*.midi midi midi type 0 and type 1

*.ape ape ape -

Picture File Support

File Extension Type Resolution
*.jpg
*.jpeg JPEG 15360x8640

*.png PNG 4096x4096
*.bmp BMP 4096x4096
*.mpo MPO 15360x8640
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Notes on the USB connection
•	 Your player supports USB storage media, MP3 

players, digital cameras, and USB card readers.
•	 Some USB/digital camera devices may not be 

compatible with the player.
•	 Your player supports the FAT16, FAT32, and 

NTFS files systems.
•	 Connect USB devices directly to the player's 

USB port. Connecting through a USB cable 
may cause compatibility problems.

•	 Inserting more than one memory device into 
a multi-card reader may cause the reader to 
operate improperly.

•	 The player does not support the PTP protocol.
•	 Do not disconnect a USB device during a 

"loading" process.
•	 The bigger the image resolution, the longer the 

image takes to display.
•	 This player cannot play MP3 files with DRM 

(Digital Rights Management) downloaded from 
commercial sites.

•	 Your player only supports video that is under 
30fps (frame rate).

•	 Your player only supports USB Mass Storage 
Class (MSC) devices such as thumb drives and 
USB HDD. (HUB is not supported.)

•	 Certain USB HDD Devices, multi-card readers 
and thumb drives may not be compatible with 
this player.

•	 If some USB devices require excessive power, 
they may be limited by the circuit safety device.

•	 If playback from a USB HDD is unstable, provide 
additional power by plugging the HDD into a 
wall socket. 
If the problem continues, contact the USB HDD 
manufacturer.

•	 SAMSUNG is not responsible for any data file 
damage or data loss.

•	 Your player does not support NTFS compressed, 
sparse, or encrypted files. 
-- You can repair or format a USB device on 

your Desktop PC. (MS-Windows OS only)

AVCHD (Advanced Video Codec High 
Definition)
•	 This player can play back AVCHD format discs. 

These discs are normally recorded and used in 
camcorders.

•	 The AVCHD format is a high definition digital 
video camera format.

•	 The MPEG-4 AVC/H.264 format compresses 
images with greater efficiency than the 
conventional image compressing format.

•	 Some AVCHD discs use the "x.v.Color" format. 
This player can play back AVCHD discs that use 
"x.v.Color" format.

•	 "x.v.Color" is a trademark of Sony Corporation.
•	 "AVCHD" and the AVCHD logo are trademarks 

of Matsushita Electronic Industrial Co., Ltd. and 
Sony Corporation.

|| NOTEs |
\\ Some AVCHD format discs may not play, depending on 

the recording conditions. 
AVCHD format discs need to be finalized.

\\ "x.v.Color" offers a wider color range than normal DVD 
camcorder discs.
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Getting Started
Accessories

Check for the supplied accessories shown below.

Batteries for Remote Control (AAA Size) 
(4301-000121)

User Manual 
(AK68-02349A)

APPS

PANDORA DIGITAL SUBTITLE INPUT

HOME

1

4

7

VOL+

2

5

8

0

VOL–

3

6

9

SOURCE

DISC MENU

SMART

TITLE MENU

VOL VOL

POPUP

A     B     C     D
SEARCH FULLSUBTITLE

SCREEN

SAMSUNG TV

– +

INFOTOOLS

RETURN EXIT

HOME

AUDIO

REPEAT

HUB

Quick Setup Guide 
(AK68-02232S)

Remote Control 
(AK59-00167A)
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Front Panel

|| NOTEs |
\\ To upgrade the player's software through the USB Host jack, you must use a USB memory stick.
\\ When the player displays the Blu-ray Disc menu, you cannot start the movie by pressing the Play button on the player or the 

remote control. To play the movie, you must select Play Movie or Start in the disc menu, and then press the v button on 
the remote control.

\\ To use Anynet+ (HDMI-CEC) function, connect an HDMI cable to HDMI 1 terminal. 
When you connect the HDMI 2 terminal, Anynet+ (HDMI-CEC) function is not available.

Rear Panel

HDMI OUT LAN
DIGITAL AUDIO OUT7.1CH ANALOG AUDIO OUT

POWER BUTTON

USB HOST
REMOTE CONTROL SENSOR

DISC TRAY

PLAY/PAUSE BUTTON

OPEN/CLOSE BUTTON

STOP BUTTON
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Remote Control

Tour of the Remote Control

Installing batteries || NOTEs |
\\ If the remote control does not operate properly:

-- Check the polarity +/– of the batteries.
-- Check if the batteries are drained.
-- Check if the remote sensor is blocked by obstacles.
-- Check if there is any fluorescent lighting nearby.

|| CAUTION |
\\ Dispose of batteries according to local environmental 

regulations. Do not put them in the household trash.

APPS

PANDORA DIGITAL SUBTITLE INPUT

HOME

1

4

7

VOL+

2

5

8

0

VOL–

3

6

9

SOURCE

DISC MENU

SMART

TITLE MENU

VOL VOL

POPUP

A     B     C     D
SEARCH FULLSUBTITLE

SCREEN

SAMSUNG TV

– +

INFOTOOLS

RETURN EXIT

AUDIO

REPEAT

HUB

HOME

Press to open and close the disc tray.

After setup, allows you to set the input 
source on your TV. 

(This button is only available in Samsung TV.)

Turn the player on and off.

Return to the previous menu.

These buttons are used both for menus 
on the player and also several Blu-ray Disc 

functions.

Press the number buttons to operate 
options.

Use to enter the disc menu.

Press to skip backwards or forwards. Press to search backwards or forwards.

Use to access various audio functions on a 
disc.

Press to use Apps.

Press to stop a disc.

Press to move to the Home screen.

Turn the TV on and off. 
(This button is only available for Samsung TVs.)
TV volume adjustment. 
(This button is only available for Samsung TVs.) 

Press to pause a disc.

Press to play a disc.

Press to switch the Blu-ray Disc/DVD's 
subtitle language.

Press to use the Tools menu.
Use to display the playback information.

Use to select menu items and change 
menu values.
Press to exit the menu.

Use to enter the Popup menu/Title menu.

Allows you to repeat a title, chapter, track 
or disc.

Press to search contents.
Press to use full screen function. 
During the Blu-ray Disc/DVDs playback, 
this button does not operate.
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Connections
Connecting to a TV

Connect an HDMI cable (not supplied) from the HDMI OUT jack on the back of the product to the HDMI 
IN jack on your TV. 
-- Do not connect the power cord to the wall outlet until you have made all the other connections.
-- When you change the connections, turn off all devices before you start.

|| NOTEs |
\\ To use the Anynet+ (HDMI-CEC) function, connect the HDMI cable to HDMI 1 terminal. 

If you connect the cable to the HDMI 2 terminal, the Anynet+ (HDMI-CEC) function will not be available.
\\ HDMI 2 terminal does not output the video signal.
\\ If you use an HDMI-to-DVI cable to connect to your display device, you must also connect the Digital Audio Out on the player 

to an audio system to hear audio. 
\\ An HDMI cable outputs digital video and audio, so you don't need to connect an audio cable.
\\ Depending on your TV, certain HDMI output resolutions may not work. Please refer to the user manual of your TV.
\\ When you connect the player to your TV using the HDMI cable or to a new TV, and then turn it on for the first time, the player 

automatically sets the HDMI output resolution to the highest supported by the TV.
\\ A long HDMI cable may cause screen noise. If this occurs, set HDMI Deep Color to Off in the menu.
\\ To view video in the HDMI 720p,1080i,1080p or 2160p output mode, you must use a High speed (category 2) HDMI cable.
\\ HDMI outputs only a pure digital signal to the TV. 

If your TV does not support HDCP (High-bandwidth Digital Content Protection), random noise appears on the screen.

Audio 
Video
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Connections
Connecting to an Audio System

You can connect the Blu-ray player to the audio system using the methods illustrated below.
-- Do not connect the power cord to the wall outlet until you have made all the other connections.
-- When you change the connections, turn off all devices before you start.

 Method 1  Connecting to an HDMI UHD supported AV receiver

•	 Connect an HDMI cable (not supplied) from the HDMI OUT jack on the back of the product to the 
HDMI IN jack on your receiver.

•	 Best quality (Recommended)

Audio/Video

Video

HDMI UHD 
supported AV 

receiver
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 Method 2  Connecting to an AV receiver that does not support HDMI UHD using HDMI cable

•	 Connect an HDMI cable (not supplied) from the HDMI OUT jack on the back of the product to the 
HDMI IN jack on your receiver.

•	 Best quality (Recommended)

|| CAUTION |
\\ Do not connect the HDMI OUT 1 and HDMI OUT 2 terminals of the product with an HDMI cable.

VideoAudio

Or

HDMI Receiver
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Connections
 Method 3  Connecting to an Audio System (7.1 Channel Amplifier)

•	 Using 7.1CH audio cables (not supplied), connect the 7.1CH ANALOG AUDIO OUT terminals on the 
rear of the Player to the 7.1CH ANALOG AUDIO IN terminals of your Amplifier.

•	 Better Quality

 Method 4  Connecting to an AV receiver with Dolby Digital or DTS decoder

•	 Using a digital Optical cable (not supplied), connect the Optical Digital Audio Out jack on the product to 
the Digital Optical In jack of the receiver.

•	 Good quality
•	 You will hear sound only through the front two speakers with Digital Output set to PCM.

|| NOTEs |
\\ The front left and right outputs on your player and 7.1 channel amplifier must be connected to hear disc menu audio from 

certain Blu-ray discs.
\\ When connecting to a 5.1 channel home theater or receiver, connect all the Analog Audio output jacks from the player 

except for the Surround Back Left/Surround Back Right outputs.

SURR. : SURROUND
SURROUND BACK

Audio

7.1 Channel 
Amplifier
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Connecting to a Network Router

You can connect your player to your network 
router using one of the methods illustrated below.
To use the AllShare network functionality, you 
must connect your PC to your network as shown 
in the illustrations. 
The connection can be wired or wireless.

Wired Network

|| NOTEs |
\\ Your router or your Internet Service Provider's policies 

may prevent the player from accessing Samsung's 
software update server. If this occurs, contact your 
Internet Service Provider (ISP) for more information.

\\ DSL users, please use a router to make a network 
connection.

Wireless Network

|| NOTEs |
\\ If your wireless router supports DHCP, this player can use 

a DHCP or static IP address to connect to the wireless 
network.

\\ Set your wireless router to Infrastructure mode. Ad-hoc 
mode is not supported.

\\ The player supports only the following wireless security 
key protocols:
-- WEP (OPEN/SHARED), WPA-PSK (TKIP/AES),  

WPA2-PSK (TKIP/AES)
\\ Select a channel on the wireless router that is not 

currently being used. If the channel set for the wireless 
router is currently being used by another device nearby, it 
will result in interference and communication failure.

\\ If you select the Pure High-throughput (Greenfield) 
802.11n mode and set the Encryption type on your router 
to WEP, TKIP or TKIP-AES (WPS2Mixed), the player will 
not support a connection in compliance with new Wi-Fi 
certification specifications.

\\ Wireless LAN, by its nature, may cause interference, 
depending on the operating conditions (router 
performance, distance, obstacles, interference by other 
radio devices, etc).

Broadband 
service

Broadband 
service

Broadband modem 
(with integrated router)

Broadband 
modem 

Router

Or

Broadband 
service

Wireless Router
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Settings
The Initial Settings Procedure

•	 The Home screen will not appear if you do not 
configure the initial settings.

•	 The OSD (On Screen Display) may change in this 
player after you upgrade the software version.

•	 The access steps may differ depending on the menu 
you selected.

After you have connected the player to your TV, 
turn on the TV and player. When you turn on the 
player the first time, the player's Initial Settings 
screen appears on the TV. The Initial Setting 
procedure lets you set the On Screen Display 
(OSD) and menu languages, the aspect ratio 
(screen size), the network type, and connect 
the player to your network. For complete Initial 
Settings instructions, see the Quick Setup Guide.

|| NOTEs |
\\ If you skip Network Setup during the Initial Settings 

procedure, you can configure your network settings later. 
See "Configuring Your Network Connection" on pages 
29~31 for instructions.

\\ If you want to display the Initial Settings screen again and 
make changes, select Settings > System > Setup in 
the Home screen or select the Reset option. (See pages 
25 or 28)

\\ If you want to use an Anynet+(HDMI-CEC) function, 
please follow the instructions below.
1)	 Connect the player to an Anynet+(HDMI-CEC)-

compliant Samsung TV using HDMI Cable.
2)	 Set the Anynet+(HDMI-CEC) feature to On in both the 

TV and the player.
3)	 Set the TV to the Initial Settings Procedure.

The Home Screen

1
Apps : Gives you access to various for pay or free-
of-charge applications you can download.

2

Photos, Videos & Music : Lets you play photos, 
Videos or music content from Disc, USB, PC or 
mobile devices.

3

Settings : Opens the player's menu where you 
can set various functions to suit your personal 
preferences.

4 Web Browser : Provides access to the Internet.

5
Recommended Apps : Gives you direct access to 
recommended applications.

6

Movies & TV Shows : Lets you download movies 
and TV Shows from the Internet.

|| NOTEs |
\\ Depending on your country, this menu function 

may not be supported.

|| NOTEs |
\\ If you leave the player in the stop mode for more than  

5 minutes without using it, a screen saver will appear on 
your TV. If the player is left in the screen saver mode for 
more than 20 minutes, the power will automatically turn off.

Movies & TV 
Shows

Apps Photos, 
Videos &  
Music

Web Browser	 Settings

a Samsung Account    d Screen Mirroring

6

1

5

3

2

4

Go to Apps and connect to the network  
to get recommended apps.
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Accessing the Settings Screen

1.	 Select Settings on the Home screen, and 
then press v button. The Settings screen 
appears.

2.	 To access the menus, sub-menus, and 
options on the Settings screen, please refer 
to the remote control illustration below.

Buttons on the Remote Control Used 
for the Settings Menu

1 HOME Button : Press to move to the Home screen.

2 RETURN Button : Return to the previous menu.

3

v (Enter) / DIRECTION Buttons :
•	 Press ▲▼◄► to move the cursor or select an 

item.
•	 Press the v button to activate the currently 

selected item or confirm a setting.

4 EXIT Button : Press to exit the current menu.

Detailed Function Information
Each Settings function, menu item, and individual 
option is explained in detail on-screen. To view an 
explanation, use the ▲▼◄► buttons to select the 
function, menu item, or option. The explanation 
will usually appear on the right side of the screen.  
A short description of each Settings function 
starts on the next page. Additional information on 
some of the functions is also in the Appendix of 
this manual.

APPS

PANDORA DIGITAL SUBTITLE INPUT

HOME

1

4

7

VOL+

2

5

8

0

VOL–

3

6

9

SOURCE

DISC MENU

SMART

TITLE MENU

VOL VOL

POPUP

A     B     C     D
SEARCH FULLSUBTITLE

SCREEN

SAMSUNG TV

– +

INFOTOOLS

RETURN EXIT

HOME

AUDIO

REPEAT

HUB

1

2 4

3

Display

UHD Output	 Auto

3D Settings	

TV Aspect Ratio	 16:9 Original

BD Wise	 Off

Resolution	 Auto

Movie Frame (24Fs)	 Auto

DVD 24Fs Conversion	 Off

Display

Audio

Network

Smart Features

System

Support

Settings
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Settings Menu Functions 

Display

UHD Output

This option outputs HDMI video at UHD resolution. This 
is only available when Movie Frame is set to Auto.

|| NOTEs |
\\ To use this feature, you must connect the player to a device 

that supports UHD resolution and you must have content that 
plays at 24Fs (film speed).

3D Settings

Select whether to play a Blu-ray Disc with 3D contents 
in 3D Mode.
•	 If you move to the Home or Apps screen while in 3D 

mode, the player will switch to 2D automatically.

TV Aspect Ratio Lets you adjust the output of the player to the screen 
size and screen format of your TV.

BD Wise

BD Wise is Samsung's latest inter-connectivity feature. 
When you connect a Samsung player and a Samsung 
TV with BD Wise to each other via HDMI, and BD Wise 
is on in both the player and TV, the player outputs video 
at the video resolution and frame rate of the Blu-ray 
Disc/DVD.

Resolution

Set the output resolution of the HDMI video signal to BD 
Wise, Auto, 1080p, 1080i, 720p or 480p.  
The number indicates the number of lines of video per 
frame. 
The i and p indicate interlaced and progressive scan, 
respectively. Generally, the more lines, the higher quality.

Movie Frame (24Fs)

If the player is connected to a 24Fs compatible TV, 
setting the Movie Frame (24Fs) feature to Auto lets the 
player adjust its HDMI output to 24 frames per second 
automatically for improved picture quality.
•	 You can enjoy the Movie Frame (24Fs) feature only on 

a TV supporting this frame rate.
•	 Movie Frame is only available when the player is in the 

HDMI 1080i or 1080p output resolution modes.
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Display
DVD 24Fs Conversion 

Converts DVD playback to 24 frames per second and 
outputs it via HDMI. This option is only available when 
Movie Frame (24Fs) is set to Auto.

Smart Hub Screen Size Lets you select the optimal size for the Smart Hub 
Screen.

HDMI Color Format

Lets you set the color space format for the HDMI output 
so that it matches the capabilities of the connected 
device (TV, monitor, etc). The screen goes black 
momentarily after you have selected a format.

HDMI Deep Color
Lets you set the product to output HDMI video with 
Deep Color. Deep Color provides more accurate color 
reproduction with greater color depth.

Progressive Mode Lets you improve picture quality when viewing DVDs.

Audio
Digital Output

Lets you select the digital audio output format that is 
suitable for your TV or AV Receiver. For more details, 
see the digital output selection table on page 65.

PCM Downsampling

Lets you choose to have 96Khz PCM signals 
downsampled to 48Khz before they are outputted to an 
amplifier. Choose On if your amplifier or receiver is not 
compatible with a 96Khz signal.

Dynamic Range Control

Lets you apply dynamic range control to Dolby Digital, 
Dolby Digital Plus, and Dolby TrueHD audio.

��Auto : Automatically controls the dynamic range of 
Dolby TrueHD audio, based on information in the 
Dolby TrueHD soundtrack. Also turns dynamic range 
control on for Dolby Digital and Dolby Digital Plus. 
��Off : Leaves the dynamic range uncompressed, 
letting you hear the original sound. 
��On : Turns dynamic range control on for all three 
Dolby formats. Quieter sounds are made louder and 
the volume of loud sounds is reduced.

Downmixing Mode

Lets you select the multi-channel downmix method that 
is compatible with your stereo system. You can choose 
to have the player downmix to normal stereo or to 
surround compatible stereo.
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Audio DTS Neo:6 Mode You can enjoy multichannel sound via HDMI output from 

a 2 channel audio source.

Audio Sync

In some cases when the product is connected to a 
digital TV, the audio signal may not synchronize with the 
video signal. If this occurs, adjust the audio delay time 
to match the video signal.
•	 You can set the audio delay time between 0 msec 

and 200 msec. 
Adjust it to the optimal setting.

|| NOTEs |
\\ The audio delay time you specify may not be exact depending 

on the played content.

HDMI Audio Output

Set HDMI audio to output through HDMI1 or HDMI2.
��Auto : Audio output will be set automatically based 
on the devices connected to HDMI1 and HDMI2.
��HDMI1 : Audio will output to the device connected to 
HDMI1.
��HDMI2 : Audio will output to the device connected to 
HDMI2.

Speaker Settings

Lets you select the kind, size, and number of speakers 
you have attached to your player, adjust the following 
speaker settings for the speakers attached, and turn the 
test tone on and off so you can test the speakers.

��Size : Lets you select the size of each kind of 
attached speaker - Large or Small - or indicate that 
you don't have a particular kind of speaker attached 
by selecting None. If you select None for a kind of 
speaker, that kind of speaker will be grayed out on 
the Level and Distance screens.
�� Level : Lets you adjust the relative loudness of each 
speaker from 0dB to -6dB. For example, if you like 
deep bass, you can increase the loudness of the 
subwoofer by 6dB.
��Distance : Lets you adjust the relative distance of 
each speaker from the listening position up to 30 feet. 
The farther the distance, the louder the speaker will 
be.
�� Test Tone : Lets you run the Test Tone function so 
you can test your adjustments. Setting Test Tone to 
On turns the Test Tone on. Setting it to Off turns it off.
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Network Network Status Lets you check the current network and Internet status.

Network Settings
Configure the network connection so you can enjoy 
various features such as Internet services or AllShare 
functionality, and perform Software Updates.

Wi-Fi Direct

Lets you connect a Wi-Fi Direct device to the player 
using a peer-to-pear network, without the need for a 
wireless router.  
Note that if the player is connected to a wireless network, 
it may be disconnected when you use Wi-Fi Direct.

|| NOTEs |
\\ Text files, such as files with a .TXT or .DOC extension, will not 

display when you are using the Wi-Fi Direct function.

AllShare Settings
Lets you control which devices on your network, such 
as smart phones and tablets, can share content with 
your Blu-ray Disc Player.

Device Name Lets you input a name for the player that will identify it 
on your networks.

BD-Live Settings

Set various BD-Live functions. BD-Live allows you to 
access extra features available on some Blu-ray Discs if 
you are connected to the Internet.

��BD-Live Internet Connection : Lets you fully allow, 
partly allow, or prohibit a BD-Live Internet connection.
��BD Data Management : Manage BD data 
downloaded from a BD-Live service or Blu-ray Disc.

Smart Features

Apps Settings 

Lets you configure App notification settings and view 
basic info about your Apps.

��Push Notification Settings : Receive notifications 
from selected services.
��Properties : See basic info about Apps.

VOD Rating Lock

You can lock access to Video on Demand (VOD) 
content based on its rating.

|| NOTEs |
\\ Depending on your country, this menu function may not be 

supported.
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Caption

The function is used for VOD playback that supports 
closed caption display. 
Use it to change displayed caption's font color and size.

|| NOTEs |
\\ Setting the function may not work with some VOD services 

that don't support closed caption display.
\\ For certain VOD services, the function's settings may not be 

applied.

Terms & Conditions, 
Privacy Policy

You must review and agree to both the Smart Hub 
Terms & Conditions and the privacy policy in order to 
enjoy Smart Hub services.

Reset Smart Hub Resets the Smart Hub and Samsung account settings 
stored on your device.

System Setup Lets you re-run the Initial Settings procedure. See the 
Quick Setup Guide for details.

Quick Start

Lets you set the player to turn on quickly by decreasing 
the boot time.

|| NOTEs |
\\ If this function is set to On, Standby power consumption will 

be increased.

Language

You can select the language you prefer for the On-
screen menu, disc menu, audio, subtitles, etc.
•	 The language you select for the disc menu, disc 

audio, or subtitles will only appear if it is supported on 
the disc.

Device Manager

You can connect a wireless USB keyboard or mouse to 
the USB port on the front of the player. 

��Keyboard Settings : Lets you configure a wireless 
USB keyboard connected to the player. 

|| NOTEs |
\\ You can use the keyboard only when a QWERTY keyboard 

screen or window appears in the Web Browser.
��Mouse Settings : Lets you configure a wireless USB 
mouse connected to the player. You can use the 
mouse in the player's menu and the Web Browser in 
the same way you use a mouse on your PC.
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System 

Device Manager

`` To use a mouse with the player's menu:

1.	 Connect the USB mouse to the player.
2.	 Click the primary button you selected in Mouse 

Settings. The Simple Menu appears. 
3.	 Click the menu options you want.
|| NOTEs |
\\ Some USB HID keyboards and mice may not be compatible 

with your product.
\\ Some HID keyboard keys may not work.
\\ Wired USB keyboards are not supported.
\\ Some applications may not be supported.
\\ If a wireless HID Keyboard does not operate because of 

interference, move the keyboard closer to the player.

Security

The default security PIN is 0000. Enter the default PIN to 
access the security function if you haven't created your 
own PIN. After you have accessed the security function 
for the first time, change the PIN using the Change PIN 
function.

��BD Parental Rating : Prevents playback of Blu-ray 
Discs with a rating equal to or above a specific age 
rating you have set unless the PIN is entered.
��DVD Parental Rating : Prevents playback of DVDs 
with a rating above a specific numerical rating you 
have set unless the PIN is entered.
��Change PIN : Change the 4-digit PIN used to access 
security functions.

`` If you forget your PIN:

1.	 Remove any disc or USB storage device.
2.	 Press and hold the @ button on the top panel for 5 

seconds or more. 
The initialization message appears on the screen, 
and the power will turn off automatically.  
When you turn your product on again, all the 
settings will be reset.
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System 

General

You can change the options listed below to match your 
preferences.

�� Front Display : Change the brightness of the front 
panel.
�� Time Zone : Select the time zone in which you live.
��Menu Transparency : Adjust the transparency of the 
menu box.

Anynet+ (HDMI-CEC)

Anynet+ is a convenient function that offers linked 
operations with other Samsung players that have the 
Anynet+ feature and lets you control those products 
with one Samsung TV remote. To operate this function, 
you must connect this player to an Anynet+ Samsung 
TV using an HDMI cable.

Support 

Remote Management

When activated, lets Samsung Call Center agents 
diagnose and fix problems with the product remotely. 
Requires an active Internet connection.

|| NOTEs |
\\ Remote Management service might not be available in some 

countries.
\\ Contact your nearest service center for your PIN code and tell 

the code to the person in charge. It enables remote diagnosis 
of the product and required measures.

Software Update For more information about the Software Update 
function, see "Upgrading Software" on pages 33~34.

Contact Samsung Provides contact information for assistance with your 
player.

Reset

Resets all settings to their default settings except for the 
network and Smart Hub settings, and then launches the 
Setup function. 
The default security PIN is 0000.
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Networks and the Internet

When you connect this player to a network, 
you can use network based applications and 
functions such as Smart Hub and BD-LIVE, 
and upgrade the player's software through the 
network connection. For more information about 
accessing and using Internet services, see the 
Network Services chapter of this manual on pages 
47~58. Instructions for configuring the network 
connection start below.

Configuring Your Network Connection
Before you begin, contact your ISP to find out 
if your IP address is static or dynamic. If it is 
dynamic, and you have a wired or wireless 
network, we recommend using the Automatic 
configuration procedures described below. 
If you are connecting to a wired network, connect 
the player to your router using a LAN cable before 
you start the configuration procedure. 
If you are connecting to a wireless network, 
disconnect any wired network connection before 
you begin. 
To begin configuring your network connection, 
follow these steps:

Wired Network

ĞĞ Wired - Automatic

1.	 In the Home screen, select Settings, and 
then press the v button.

2.	 Select Network, and then press the v 
button.

3.	 Select Network Settings, and then press the 
v button.

4.	 Select Wired in the Network Settings screen, 
and then press the v button.

5.	 Select Connect button, and then press the 
v button. The product detects the wired 
connection, verifies the network connection 
and then connects to the network.

ĞĞ Wired - Manual
If you have a static IP address or the Automatic 
procedure does not work, you'll need to set the 
Network Settings values manually.
Follow Steps 1 and 2 in Wired Network, and then 
follow these steps:
1.	 Select Network Status. The player searches 

for a network, and then displays the 
connection failed message.

2.	 On the bottom of the screen, select IP 
Settings, and then press the v button.  
The IP Settings screen appears.

3.	 Select the IP Setting field, and then press the 
v button.

4.	 Select Enter manually in the IP Setting field, 
and then press the v button.

5.	 Select a value to enter (IP Address, for 
example), and then press the v button.  
Use the number keypad on your remote 
control to enter the numbers for the value. 
You can also enter numbers using the ▲▼ 
buttons. Use the ◄► buttons on the remote 
control to move from entry field to entry field 
within a value. When done with one value, 
press the v button.

6.	 Press the ▲ or ▼ button to move to another 
value, and then enter the numbers for that 
value following the instructions in Step 5. 

7.	 Repeat Steps 5 and 6 until you have filled in 
all values.

|| NOTEs |
\\ You can get the Network values from your Internet 

provider.
8.	 When finished entering all the values, select 

OK, and then press the v button. The 
player verifies the network connection and 
then connects to the network.
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Wireless Network
You can setup a wireless network connection in 
four ways: 
-- Wireless Automatic 
-- Wireless Manual 
-- WPS(PBC)
-- WPS(PIN)

When you configure the wireless network 
connection, any wireless network devices currently 
connected through the player or, if applicable, 
the player's current wired connection, will be 
disconnected.

ĞĞ Wireless - Automatic

1.	 In the Home screen, select Settings, and 
then press the v button.

2.	 Select Network, and then press the v 
button.

3.	 Select Network Settings, and then press the 
v button.

4.	 Select Wireless in the Network Settings 
screen, and then press the v button. The 
player searches for and then displays a list of 
the available networks.

5.	 Select the desired network, and then press 
the v button.

6.	 On the Security screen, enter your network's 
Security Code or Pass Phrase. 
Enter numbers directly using the number 
buttons on your remote control. Enter letters 
by selecting a letter with an arrow button, and 
then pressing v button.

|| NOTEs |
\\ To view the password as you enter it, use the arrow 

buttons to select Show Password on the right side, and 
then press v button.

7.	 When done, select Done and then press the 
v button. The player verifies the network 
connection and then connects to the 
network.

8.	 When verification is complete, select OK, and 
then press the v button.

|| NOTEs |
\\ You should be able to find the Security Code or Pass 

Phrase on one of the set up screens you used to set up 
your router or modem.

ĞĞ Wireless - Manual
If you have a static IP address or the Automatic 
procedure does not work, you'll need to set the 
Network Settings values manually.
1.	 Follow the directions in Wireless - Automatic 

through Step 5.
2.	 The player searches for a network, and then 

displays the connection failed message.
3.	 On the bottom of the screen, select IP 

Settings, and then press the v button.  
The IP Settings screen appears.

4.	 Select the IP Setting field, and then press the 
v button.

5.	 Select Enter manually in the IP Setting field, 
and then press the v button.

linksys3
solugen_edu#2
iptime23
solugen_edu#1

You can connect your Blu-ray 
player to the internet. Please  
select which wireless network to  
use.

	 Refresh	 WPS(PBC)

Network Settings
Select your network type.
Network type	 Wireless

Wireless network
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6.	 Select a value to enter (IP Address, for 
example), and then press v button. Use 
the number keypad on your remote control 
to enter the numbers for the value. You can 
also enter numbers using the ▲▼ buttons. 
Use the ◄► buttons on the remote control 
to move from entry field to entry field within a 
value. When done with one value, press the 
v button.

7.	 Press the ▲ or ▼ button to move to another 
value, and then enter the numbers for that 
value following the instructions in Step 6.

8.	 Repeat Steps 6 and 7 until you have filled in 
all values.

|| Notes |
\\ You can get the Network values from your Internet 

provider.
9.	 When finished, select OK, and then press the 

v button. The Security Screen appears.
10.	 On the Security screen, enter your network's 

Security Code or Pass Phrase. Enter 
numbers directly using the number buttons 
on your remote control. Enter letters by 
selecting a letter with the ▲▼◄► buttons, 
and then pressing the v button.

11.	 When finished, select Done at the right of the 
screen, and then press the v button.  
The player verifies the network connection 
and then connects to the network.

12.	 After the player verifies the network, select 
OK, and then press the v button.

ĞĞ WPS(PBC)

1.	 In the Home screen, select Settings, and 
then press the v button.

2.	 Select Network, and then press the v 
button.

3.	 Select Network Settings, and then press the 
v button.

4.	 Select Wireless in the Network Settings 
screen, and then press the v button.

5.	 Press the ▲ button on your remote, and then 
press the ► button to select the WPS(PBC).

6.	 Press the v button on your remote. The 
"Press the PBC button" message appears.

7.	 Press the WPS(PBC) button on your router 
within two minutes. Your player automatically 
acquires all the network settings values it 
needs and connects to your network. 
The Network Status screen appears. The 
player connects to the network after the 
network connection is verified.

ĞĞ WPS(PIN)
Before you begin, open the router's setup menu 
on your PC and access the screen with the WPS 
PIN entry field. 
1.	 In the Home screen, select Settings, and 

then press the v button.
2.	 Select Network, and then press the v 

button.
3.	 Select Network Settings, and then press the 

v button.
4.	 Select Wireless in the Network Settings 

screen, and then press the v button.  
The player searches for and then displays a 
list of the available networks.

5.	 Select the desired network, and then press 
the ► button.

6.	 Select the WPS(PIN), and then press the  
v button. The PIN pop-up appears.

7.	 Enter the PIN into the WPS PIN entry field in 
the router's Set Up screen and then save the 
the screen.

|| NOTEs |
\\ Contact the manufacturer of the router for instructions 

explaining how to access the route's Set Up screens or 
refer to the router's user's manual.

\\ For WPS connection, set your wireless router’s security 
encryption to AES. Setting to WEP security encryption 
does not support WPS connection.
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Wi-Fi Direct
The Wi-Fi Direct function allows you to connect 
Wi-Fi Direct devices to the player and each other 
using a peer-to-peer network, without a wireless 
router.

|| NOTEs |
\\ Some Wi-Fi Direct devices may not support the AllShare 

function if connected via Wi-Fi Direct. If this is the case, 
it is advisable to change the network connection method 
between devices.

\\ Bluetooth transmissions can interfere with the Wi-Fi 
Direct signal. Before you use the Wi-Fi Direct function, 
we strongly recommend that you turn off the Bluetooth 
function of any active mobile device.

1.	 Turn on the Wi-Fi direct device and activate 
its Wi-Fi Direct function.

2.	 In the Home screen, select Settings, and 
then press the v button.

3.	 Select Network, and then press the v 
button.

4.	 Select Wi-Fi Direct, and then press the v 
button. 
The Wi-Fi Direct devices that you can 
connect appear.

5.	 You have three ways to complete the Wi-Fi 
connection:
•	 Through the Wi-Fi device.
•	 Through the player using PBC.
•	 Through the player using a PIN.
Each is covered below.

Through the Wi-Fi Device
1.	 On the Wi-Fi device, follow the procedure on 

the device for connecting to another Wi-Fi 
Direct device. See the device's user manual 
for instructions.

2.	 When you have completed the procedure, 
you should see a pop-up on your TV screen 
saying that a device that supports Wi-Fi 
Direct has requested to connect. Select OK, 
and then press the v button to accept.

3.	 The Connecting pop-up appears, followed 
by the Connected pop-up. When it closes, 
you should see the device listed on the Wi-Fi 
Direct screen as connected.

Through the Player Using PBC
1.	 Select the Wi-Fi Direct device you want to 

connect to this player, and then press the v 
button. The PBC/PIN pop up appears.

2.	 Select PBC, and then press the v button. 
The PBC pop-up appears.

3.	 Press the PBC button on the Wi-Fi Direct 
device within 2 minutes.

4.	 The Connecting pop-up appears, followed 
by the Connected pop-up. When it closes, 
you should see the device listed on the Wi-Fi 
Direct screen as connected.

Through the Player Using a PIN
1.	 Select the Wi-Fi Direct device you want to 

connect to this player, and then press the v 
button. The PBC/PIN pop up appears.

2.	 Select PIN, and then press the v button. 
The PIN pop-up appears.

3.	 Note the PIN code in the pop-up, and then 
enter it into the appropriate field in the Wi-Fi 
Direct device you want to connect.

4.	 The Connecting pop-up appears, followed 
by the Connected pop-up. When it closes, 
you should see the device listed on the Wi-Fi 
Direct screen as connected.

|| NOTEs |
\\ The current wired or wireless network connection will be 

disconnected when you use the Wi-Fi Direct function.
\\ Text files, such as files with a .TXT or .DOC extension, will 

not display when you are using the Wi-Fi Direct function.
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Upgrading Software

The Software Update menu allows you to 
upgrade the player's software for performance 
improvements or additional services.

•	 Never turn the player off or back on manually during 
the update process.

1.	 In the Home screen, select the Settings, and 
then press the v button.

2.	 Select Support, and then press the v 
button.

3.	 Select Software Update, and then press the 
v button.

4.	 To download update software and update 
now, select Update Now, and then press the 
v button. See Update Now on this page for 
details.

5.	 To let the product download update software 
automatically when available, select Auto 
Update, and then press the v button. See 
Auto Update on page 34 for details.

|| NOTEs |
\\ The upgrade is complete when the player turns off, and 

then turns on again by itself.
\\ Samsung Electronics shall takes no legal responsibility 

for player malfunction caused by an unstable Internet 
connection or consumer negligence during a software 
Update.

\\ If you want to cancel the upgrade while the upgrade 
software is downloading, press the v button.

\\ When a system upgrade is in progress, "UPDATE" is 
displayed on the front panel.

Update Now
You can use Update Now to update the software 
through your network connection or by using a 
USB flash drive. The network instructions are 
below. The USB flash drive instructions are on the 
next page.
1.	 Select Update Now, and then press the v 

button. 
The Update now pop-up appears.

2.	 The product searches on line for the latest 
software version.

3.	 If it finds a new version, the Update Request 
pop-up appears.

4.	 Select OK. The product upgrades the 
software, turns off, and then turns on 
automatically.

5.	 If you do not select OK or Cancel in one 
minute, the product stores the new upgrade 
software. You can upgrade the software later 
using Auto Update.

6.	 If you select Cancel, the product cancels the 
upgrade.

|| NOTEs |
\\ When the system upgrade is done, check the software 

details in the Product Information section of the Contact 
Samsung screen.

\\ Do not turn off the player during the Software Update. It 
may cause the player to malfunction.
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Auto Update
You can set the Auto Update function so that the 
player downloads new upgrade software when it 
is in Auto Update mode. 
In Auto Update mode, the player is off, but its 
Internet connection is active. This allows the player 
to download upgrade software automatically, 
when you are not using it.
1.	 Press the ▲▼ buttons to select Auto 

Update, and then press the v button.
2.	 Select On or Off. 

If you select On, the player will automatically 
download new upgrade software when it is 
in Auto Update mode with the power off. If it 
downloads new upgrade software, the player 
will ask you if you want to install it when you 
turn the player on.

|| NOTEs |
\\ To use the Auto Update Mode Upgrade function, your 

player must be connected to the Internet.

< By USB >
1.	 Visit www.samsung.com.
2.	 Click SUPPORT on the top right of the page.
3.	 Enter the product's model number into the 

search field. As you enter the model number, 
a drop down will display products that match 
the model number.

4.	 Left click your product's model number in the 
drop down list.

5.	 On the page that appears, scroll down to and 
then click Firmware Manuals & Downloads.

6.	 Click Firmware in the center of the page.
7.	 Click the ZIP button in the File column on the 

right side of the page.
8.	 Click Send in the first pop-up that appears. 

Click OK in the second pop-up to download 
and save the firmware file to your PC.

9.	 Unzip the zip archive to your computer. You 
should have a single folder with the same 
name as the zip file.

10.	 Copy the folder to a USB flash drive.
11.	 Make sure no disc is inserted in the product, 

and then insert the USB flash drive into the 
USB port of the product.

12.	 In the product’s menu, go to Settings > 
Support > Software Update.

13.	 Select Update Now.
14.	 The product searches for the software on the 

USB drive. When it finds the software, the 
Update Request pop-up appears.

15.	 Select OK. The product upgrades the 
software, turns off, and then turns on 
automatically. 

|| NOTEs |
\\ There should be no disc in the player when you upgrade 

the software using the USB jack.
\\ When the system upgrade is done, check the software 

details in the Product Information section of the Contact 
Samsung screen.

\\ Do not turn off the player during the Software Update. 
It may cause the player to malfunction.

\\ Software Updates using the USB jack must be performed 
with a USB flash memory stick only.
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Media Play
Your Blu-ray Disc Player can play content located 
on Blu-ray/DVD/CD discs, USB devices, PCs, 
smart phones, tablets, and on the Web.  
To play content located on your PC or on mobile 
devices, you must connect them and this product 
to your network. To play content on your PC, you 
must also install Allshare network software on your 
PC.

|| NOTEs |
\\ You can play contents on your PC using other programs 

compatible with Allshare network software, however, we 
recommend that you use Allshare network software.

Playing Commercial Discs

1.	 Press the 8 button to open the disc tray.
2.	 Place a disc gently into the disc tray with the 

disc’s label facing up. 

3.	 Press the 8 button to close the disc tray. 
Playback starts automatically.

4.	 If playback does not start automatically, press 
the 6 button on the remote control.

Playing Files on a USB Device

There are two methods you can use to play or 
view multimedia files located on a USB device 
through your player.

Method 1

1.	 Turn the player on.
2.	 Connect the USB device to the USB port on 

the front panel of the player. The New Device 
Connected pop-up appears.

|| NOTEs |
\\ If the pop-up does not appear, go to Method 2.

3.	 Use the ▲▼ buttons to select Photos, 
Videos, Music or All Content, and then 
press the v button. The Photos, Videos & 
Music screen appears listing the content of 
the device. Depending on how the contents 
is arranged, you will see either folders, 
individual files, or both.

|| NOTEs |
\\ Even though the player will display folders for all content 

types, it will only display files of the Content Type you 
selected in Step 2. For example, if you selected music, 
you will only be able to see music files. You can change 
this selection by returning to the Photos, Videos & Music 
screen and going to Step 4 in Method 2 below.

Movies & TV 
Shows

Apps Photos, 
Videos &  
Music

	 Web Browser	 Settings

a Samsung Account    d Screen Mirroring

Go to Apps and connect to the network  
to get recommended apps.

Photos
Videos
Music
All Content

New device connected.

m80
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4.	 If necessary, use the the ▲▼◄► buttons 

to select a folder, and then press the v 
button.

5.	 Select a file to view or play, and then press 
the v button.

6.	 Press the RETURN button to exit a folder 
or the EXIT button to return to the Home 
screen.

7.	 Go to pages 39~46 for instructions that 
explain how to control playback of videos, 
music, and pictures on a USB device.

Method 2

1.	 Turn the player on.
2.	 Connect the USB device to the USB port on 

the front panel of the player.
3.	 Select Photos, Videos & Music on the 

Home screen, and then press the v button.
4.	 Select Photos, Videos, Music or All 

Content, and then press the v button.
|| NOTEs |
\\ Even though the player will display folders for all content 

types, it will only display files of the Content Type you 
selected in Step 2. For example, if you selected music, 
you will only be able to see music files. You can change 
this selection by returning to the Photos, Videos & Music 
screen and repeating Step 4. 

5.	 Use the ◄► buttons to select the desired 
device and then press the v button. 
Depending on how the contents are 
arranged, you will see either folders, individual 
files, or both.

6.	 If necessary, use the ▲▼◄► buttons to 
select a folder, and then press the v button.

7.	 Use the ▲▼◄► buttons to select a file to 
view or play, and then press the v button.

8.	 Press the RETURN button to exit a folder or 
the EXIT button to return to Home screen.

9.	 Go to pages 39~46 for instructions that 
explain how to control playback of videos, 
music, and pictures on a USB device.

|| NOTEs |
\\ If you insert a disc when playing a USB device, the device 

mode changes to "Disc" automatically.

Playing a Disc with User Recorded 
Content

You can play multimedia files you have recorded 
on Blu-ray, DVD, or CD discs.
1.	 Place a user recorded disc into the disc 

tray with the disc’s label facing up, and then 
close the tray. The Device Connected pop-up 
appears.

2.	 Use the ▲▼ buttons to select the type of 
content you want to view or play - Photos, 
Videos, Music, or All Content - and then 
press the v button.

|| NOTEs |
\\ Even though the player will display folders for all content 

types, it will only display files of the Content Type you 
selected in Step 2. For example, if you selected music, 
you will only be able to see music files. You can change 
this selection by returning to the Photos, Videos & Music 
screen and repeating Step 2.

3.	 A screen appears listing the contents of the 
disc. Depending on how the contents are 
arranged, you will see either folders, individual 
files, or both.

4.	 If necessary, use the ▲▼◄► buttons to 
select a folder, and then press the v button.
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5.	 Use the ▲▼◄► buttons to select a file to 
view or play, and then press the v button.

6.	 Press the RETURN button one or more times 
to exit a current screen, exit a folder, or to 
return to the Home screen.  
Press the EXIT button to return directly to the 
Home Screen.

7.	 Go to pages 39~46 for instructions that 
explain how to control playback of videos, 
music, and pictures on a disc.

Using the Allshare Network 
Function

Allshare software lets you play Photos, Videos, 
or Music located on your PC or your Allshare 
compatible device through the player using a 
wireless connection.

To Download the Allshare Software

AllShare makes it easy to retrieve and enjoy media 
files from computers and DLNA-enabled devices. 
However, computers need to be installed with 
AllShare PC and mobile devices need to support 
AllShare. For more information, visit the Samsung 
Content & Service portal (http://link.samsung.
com).
-- You may experience compatibility issues when 

attempting to play media files via a third-party 
DLNA server.
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Playing Content Located on Your PC 
or Allshare Device through the Blu-ray 
Disc Player

1.	 Connect the Blu-ray Disc Player, your PC, 
and/or your Allshare compatible device to the 
same wireless network.

2.	 Follow the directions in the Allshare software 
Installation/Instruction manual to set up 
devices and files for playing or viewing.

3.	 Select Photos, Videos & Music on the 
player's Home screen, and then press the 
v button. The Photos, Videos & Music 
screen appears.

4.	 Select the type of content you want to play 
- Photos, Videos, Music, or All Content - 
and then press the v button.

5.	 On the next screen, select Allshare, and then 
press the v button.

6.	 In the list of Allshare connected devices that 
appears, select your PC or other Allshare 
compatible device, and then press the v 
button. A screen listing the available files 
appears.

7.	 Select the file you want to play or view, and 
then press the v button.

Controlling the Playback of Content 
Located on Your PC with Your Smart 
Phone

(Only available with Samsung phones supporting 
Allshare functionality.)
1.	 Connect the Blu-ray Disc Player, your PC, 

and your Allshare compatible cellular phone 
to the same wireless network.

2.	 Follow the directions in the Allshare software 
Installation/Instruction manual to set up 
devices and files for playing or viewing.

3.	 On your computer, using the Allshare 
software, confirm your phone is connected.

4.	 On the phone, select the file you want to view 
or play, and then select the Blu-ray player as 
the playback device.

5.	 On the phone, start playback.

Allshare Connection

PC Blu-ray Disc Player

Play back 
PC's files

AllShare 
Connection

PC Blu-ray Disc Player

Play back 
PC's files

Allshare Smart Phone

Control PC's files on the 
Blu-ray Disc Player
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Controlling Video Playback

You can control the playback of video content located on a Blu-ray/DVD disc, USB, mobile device or PC. 
Depending on the disc or contents, some of the functions described in this manual may not be available.

Buttons on the Remote Control used for Video Playback

�� Using the disc menu, title menu, popup 
menu, and title list

DISC MENU 
button

During playback, press this button to 
display the Disc menu.

TITLE MENU 
button

During playback, press this button to 
display the Title menu.
•	 If your disc has a playlist, press the 

View to go to the playlist.

POPUP MENU 
button

During playback, press this button to 
display the Popup menu.

Using the Tools Menu
During playback or in pause mode, press the 
TOOLS button.

Play from the 
Beginning

Select to return to the beginning of the 
movie, and then press the v button.

3D

Use 3D menu to select Side by Side 
or Top and Bottom option if the 3D 
content currently playing does not 
properly appear in 3D mode.

|| NOTEs |
\\ Use 3D menu for 3D contents only. 

If applied to 2D contents, it may not 
be displayed properly.

Movie Note

Movie Note provides information such 
as director, cast, synopsis, etc.

|| NOTEs |
\\ This function is available if the disc 

includes Movie Note information 
and the player is connected to a 
network.

Search Scene
You can use the Search Scene function 
during playback to view or start a 
movie from the scene of your choice.

�� Playback related buttons
The player does not play sound in Search, Slow or 
Step mode.
•	 To return to normal speed playback, press the 

6 button.

6 button Starts playback.

5 button Stops playback.

7 button Pauses playback.

Fast Motion 
Play

During playback, press the 3 or 4 
button. 
Each time you press the 3 or 4 
button, the playback speed will change.

Slow Motion 
Play

In pause mode, press the 4 button. 
Each time you press the 4 button, the 
playback speed will change.

Step Motion 
Play

In pause mode, press the 7 button. 
Each time you press the 7 button, a 
new frame appears.

Skip Motion 
Play

During playback, press the 1 or 2 
button. 
Each time you press 1 or 2 button, 
the disc moves to the previous or next 
chapter or file.
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Search Scene

|| NOTEs |
\\ If the index information in the file 

is damaged or the file does not 
support indexing, you will not be 
able to use the Search Scene 
function.

\\ If you are using the Allshare function 
after connecting to a computer 
through your network, Search 
Scene may not be supported.

Search Titles

If there is more than one movie on the 
disc or device, select to start a different 
title.
1.	 Select Search Titles, and then 

press the v button.
2.	 Use the ▲▼ buttons to select 

a title, and then press the v 
button.

Search 
Chapters

Select to play the chapter of your 
choice.
1.	 Select Search Chapters, and then 

press the v button.
2.	 Use the ▲▼ buttons to select a 

chapter, and then press the v 
button.

Search Time 
Bar

Select to play the movie from a 
selected time point.
1.	 Select Search Time Bar, and then 

press the v button.
2.	 Using the number buttons, enter 

the time point you want to go to, 
and then press the v button.

|| NOTEs |
\\ You can also use the ◄► buttons 

to advance or rewind the movie. 
The movie advances or rewinds one 
minute each tme you press the ◄ 
► buttons.

Repeat Mode

Select to repeat a title, chapter, or 
specific section.
-- Off : Select to return to normal 

playback.
-- Title : Choose to repeat a selected 

title.
-- Chapter : Choose to repeat a 

specific chapter.
-- Repeat A-B : Choose to repeat a 

specific section. 
1.	 Press the ▲▼ buttons to select 

repeat A-B, and then press the 
v button.

2.	 Press the v button at the point 
where you want repeat play to start 
(A). Let the movie play.

3.	 Press the v button at the point 
where you want repeat play to stop 
(B).

|| NOTEs |
\\ You must set point (B) at least 5 

seconds of playing time after point 
(A).

Picture Mode

Select to set the picture mode.
-- Dynamic : Increases sharpness and 

brightness.
-- Standard : Choose this setting for 

most viewing applications.
-- Movie : The best setting for 

watching movies.
-- User : Lets you adjust the sharpness 

and noise reduction function 
respectively.

|| NOTEs |
\\ When you use the BD wise function, 

this menu will not appear.

Audio Select to set the desired audio 
language.
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Subtitle

Select to set the desired subtitle 
language.
-- You can also operate this function 

by pressing the SUBTITLE button on 
the remote control.

Subtitle 
Settings

Select to set the desired subtitle 
options.

Angle

Select to view a scene from another 
angle. The Angle option displays the 
number of angles available to view. 
When a Blu-ray Disc/DVD contains 
multiple angles of a particular scene, 
you can change angle.

BONUSVIEW 
Video Select to set the desired bonusview 

option.BONUSVIEW 
Audio

Full screen
Select to set the size of the video 
image. Choose Original, Mode 1 
(larger), or Mode 2 (largest).

Information Select to view video file information.

|| NOTEs |
\\ Depending on the disc or storage device, the Tools menu 

may differ or not be shown. 
\\ Video files with high bitrates of 20Mbps or more strain 

the player's capabilities and may stop playing during 
playback.

Using the View & Options Menus 

Using the View Menu 
On the video file playback screen, use the ▲▼◄► 
buttons to select View and then press the v 
button.

Title Displays all the video files on the media 
or storage device by title.

Date

Displays all the folders with videos by 
date. If you select a folder, and then 
press the v button, displays all the 
videos in the folder by date.

Folder Displays all the folders on the media or 
storage device.

Playlist Displays available play lists.

Title List
Displays all the video files on the media 
or storage device by title. Alternate to 
Title.

|| NOTEs |
\\ Depending on the disc or storage device, the View menu 

may differ or not be shown.

Using the Options Menu 
On the video file playback screen, use the ▲▼◄► 
buttons to select Options and then press the v 
button.

Play Selected

Lets you create a playlist by selecting 
specific files to play. It works essentially 
the same way for all media. See 
Creating a Playlist on an Audio CD on 
pages 43~44.

Send

Select to upload selected files to on-
line sites (Picasa, Facebook etc) or a 
device. To use this function, you need 
to establish an account with the on-line 
site, and then log in using the Log In 
function.

Delete Select to delete a file from a device.

|| NOTEs |
\\ Depending on the disc or storage device, the Options 

menu may differ or not be shown.
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Controlling Music Playback

You can control the playback of music content 
located on a DVD, CD, USB, mobile device or PC.
Depending on the disc or contents, some of the 
functions described in this manual may not be 
available.

Buttons on the Remote Control used 
for Music Playback

1

NUMBER buttons : If numbered tracks are displayed, 
press the number of a track.The selected track is 
played.

2 12 button : Moves to the previous/next track.

3 5 button : Stops a track.

4

Fast Play (Audio CD (CD-DA) only)
During playback, press the 3 or 4 button. 
Each time you press the 3 or 4 button, the 
playback speed will change.

5 7 button : Pauses a track.

6 6 button : Plays the currently selected track.

Using the View & Options Menus

Using the View Menu 
On the music file playback screen, use the ▲▼◄► 
buttons to select View, and then press the v 
button.

Track Displays all the music tracks on the 
media or storage device.

Album Displays all music on the media or 
storage device by album.

Artist Displays all the the music files on the 
media or storage device by artist.

Genre Displays all the music on the media or 
storage device by genre.

Folder Displays all the folders on the media or 
storage device.

|| NOTEs |
\\ Depending on the disc or storage device, the View menu 

may differ or not be shown.

Using the Options Menu 
On the music file playback screen, use the ▲▼◄► 
buttons to select Options and press the v button.

Play Selected

Lets you create a playlist by selecting 
specific files to play. It works essentially 
the same way for all media. See 
Creating a Playlist on an Audio CD on 
pages 43~44.

Send Select to send selected files to other 
devices.
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Ripping

The Ripping function converts CD 
audio to the mp3 format and saves the 
converted files on a USB device or the 
mobile device connected to the player. 
See Ripping on page 44.

Information Select to see the (Contents) information.

Encoding Select to manage the text encoding 
options. 

Delete Select to delete a file from the device.

|| NOTEs |
\\ Depending on the disc or storage device, the Options 

menu may differ or not be shown.

Repeating Tracks on an Audio CD
You can set the product to repeat tracks on an 
audio CD (CD-DA/MP3).
1.	 On the Playback screen, use the ▲▼◄► 

buttons to select  in the lower left corner 
of the screen, and then press the v button.

2.	 Use the ▲▼ to select the repeat mode you 
want - Off, One Song, or All - and then 
press the v button.

Shuffling Tracks on an Audio CD
You can set the product to play tracks on an audio 
CD (CD-DA/MP3) at random.
1.	 On the Playback screen, use the ▲▼◄► 

buttons to select  in the lower left corner 
of the screen, and then press the v button.

2.	 Use the ▲▼ to set the Shuffle mode On or 
Off, and then press the v button.

Creating a Playlist from an Audio CD

1.	 With the Playback screen displayed, select 
the Options button, and then press the v 
button. The Options menu appears.

2.	 Use the ▲▼ buttons to select Play Selected, 
and then press the v button. The Selection 
Play screen appears.

3.	 Use the ▲▼ buttons to select a track, and 
then press the v button. A check appears 
to the left of the track.

4.	 Repeat Step 3 to select and check additional 
tracks.

5.	 To remove a track from the list, move to the 
track, and then press the v button again. 
The check on the track is removed.

6.	 When done, press the ▲▼ button to select 
Play, and then press the v button. The 
Music Playback screen reappears listing only 
the tracks you checked. The selected tracks 
play automatically.

|| NOTEs |
\\ You can create a playlist with up to 99 tracks on Audio 

CDs (CD-DA).
\\ If you have created a playlist, Play Selected is replaced 

by Edit Playlist on the Options menu.
\\ On the Selection Play screen, you can also choose Select 

All, Clear All, and Cancel.

00:09	 00:43

TRACK 001

TRACK 001	 00:43
TRACK 002	 03:56
TRACK 003	 04:41
TRACK 004	 04:02
TRACK 005	 03:43
TRACK 006	 03:40
TRACK 007	 04:06
TRACK 008	 03:52
TRACK 009	 03:04
TRACK 010	 04:02

 Options

off off
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-- Use Select All to select all tracks. This cancels 

your individual track selections. When you press the 
RETURN button on your remote control or select the 
Play button, and then press the v button, all tracks 
will appear on the Music Playback screen, and the 
product will begin to play all tracks from Track 001.

-- Use Clear All to deselect all selected tracks at once. 
Then, select individual tracks or use Select All to 
select all the tracks, and then press the RETURN 
button on your remote control. If you do not use Select 
All or select individual tracks, the Playlist will not 
change.

-- Cancel cancels any changes you made on the Play 
Select screen. When you return to the Playback screen, 
the Playlist will be unchanged.

Ripping

1.	 Insert a USB device into the USB jack on the 
front of the product.

2.	 With the Playback screen displayed, select 
the Options and then press the v button. 
The Options menu appears.

3.	 Use the ▲▼ buttons to select Ripping, 
and then press the v button. The Ripping 
screen appears.

4.	 Use the ▲▼ buttons to select a track, and 
then press the v button. A check appears 
to the left of the track.

5.	 Repeat Step 4 to select and check additional 
tracks.

6.	 To remove a track from the list, move to the 
track, and then press the v button again. 
The check on the track is removed.

7.	 When done, select the Rip button using the 
▲▼ buttons, and then press the v button. 
The Rip pop-up appears.

8.	 Use the ▲▼ buttons to select the device to 
store the ripped files to, and then press the 
v button.

|| NOTEs |
\\ Do not disconnect the device while ripping is in progress.

9.	 If you want to cancel ripping, press the v 
button and then select Yes. Select No to 
continue ripping.

10.	 When ripping is complete, the "Successfully 
Ripped." message appears. Press the v 
button.

11.	 Press the RETURN button or select Cancel, 
and then press the v button to go back to 
the Playback screen.

|| NOTEs |
\\ This function is not available with DTS Audio CD.
\\ This function may not be supported by some discs.
\\ Ripping encodes music to the .mp3 format at 192kbps.
\\ On the Ripping screen, you can also choose Select All 

and Clear All.
-- Use Select All to select all tracks and press the v 

button. This cancels your individual track selections. 
-- Use Clear All to deselect all selected tracks at once.

Playing Photo Contents 

You can play photo contents located on a DVD, 
USB, mobile device or PC. 

Using the Tools Menu
During playback, press the TOOLS button. A 
series of icons appears at the bottom of the 
screen. The icons, which are shown from left to 
right on the screen, are shown in the same order, 
from top to bottom, in the table below.

Previous Select to move to the previous picture.

Next Select to move to the next picture.

Start / Stop 
Slide Show Select to play/pause the slide show.
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Slide Show 
Settings Select the Slide Show settings.

Zoom Select to enlarge the current picture. 
(Enlarge up to 4 times)

Rotate
Select to rotate the picture. (This will 
rotate the picture either clockwise or 
counter clockwise.)

Background 
Music

Select to listen to music while viewing 
a slide show.

Settings
Select the picture mode - Dynamic, 
Standard, Movie, or User - or display 
information about the current picture.

|| NOTEs |
\\ Depending on the disc or storage device, the Tools menu 

may differ or not be shown.
\\ To enable the background music function, the photo file must 

be in the same storage media as the music file. 
However, the sound quality can be affected by the bitrate of 
the MP3 file, the size of the photo, and the encoding method.

\\ You can't enlarge the subtitle and PG graphic in the full 
screen mode.

Using the View & Options Menus 

Using the View Menu 
On a file screen containing photo files, select the 
View and press the v button.

Title Displays all the photo files on the media 
or storage device by title.

Date
Groups all the the photo files on the 
media or storage device by date. Click a 
group to see the photos in that group.

Folder Displays all the folders on the media or 
storage device.

|| NOTEs |
\\ Depending on the disc or storage device, the View menu 

may differ or not be shown.

Using the Options Menu 
On a file screen containing photo files, select the 
Options and press the v button.

Slide show

Starts the slide show. Shows all the 
files in the current folder, one after 
another. If you want to create a slide 
show with a selected group of photos, 
see Play Selected below.

Play Selected

Lets you create a playlist by selecting 
specific photos to see. It works 
essentially the same for all media. 
See Creating a Playlist from an Audio 
CD on pages 43~44 for instructions.

Send

Select to upload selected files to an 
on-line site (Picasa, Facebook etc) or a 
device. To use this function, you need 
to establish an account with the on-line 
site, and then log in using the Log In 
function. See Using the Send Function 
on page 46.

Delete Select to delete the a file from the 
device.

|| NOTEs |
\\ Depending on the disc or storage device, the Options 

menu may differ or not be shown.
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Using the Send Function
You can upload files to an on-line site (Picasa, 
Facebook etc) or a device.
1.	 With the Photo Playback screen displayed, 

select the Options button, and then press 
the v button. The Options menu appears.

2.	 Use the ▲▼ buttons to select Send, and 
then press the v button. The Selection 
screen appears.

3.	 Use the ▲▼ buttons to select a picture, and 
then press the v button. A check appears 
to the left of the picture.

4.	 Repeat Step 3 to select and check additional 
pictures.

5.	 To remove a picture from the list, move to the 
picture, and then press the v button again. 
The check on the picture is removed.

6.	 When done, press the ▲▼ button to select 
Send, and then press the v button.  
The Send pop-up appears listing the on-line 
sites (Picassa, Facebook, etc.) or devices 
that you can send the photos to.

7.	 Select a destination, and then press the v 
button.

8.	 If you are sending the photos to an on-line 
site, the site starts. Log in and follow the 
directions on the screen.

|| NOTEs |
\\ To send photos to an on-line site you must have an 

account with that site.
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Network Services
You can enjoy various network services such as 
streaming video or on-line apps by connecting the 
player to your network.

To use network services, you must first:
1.	 Connect the player to the network. 

(See page 19)
2.	 Configure the network settings. 

(See pages 29~31)

Logging In to Your Samsung 
Account

Before you access Movies & TV Shows or Apps, 
we suggest you log in to your Samsung account.

|| NOTEs |
\\ If you do not have a Samsung account, follow the 

directions in the Quick Startup Guide to create one.
To log in to your Samsung account, follow these 
steps:
1.	 With the Home screen displayed, press the 

RED (A) button. The Log In screen appears.
2.	 Select the Email field, and then press the v 

button. The keyboard pop-up appears.
3.	 Using the keyboard, enter your e-mail 

address. When finished, select the Done 
button, and then press the v button. The 
Log In screen re-appears.

4.	 Select the Password field, and then press the 
v button. The keyboard pop-up appears.

5.	 Using the keyboard, enter your password. 
When finished, select the Done button, and 
then press the v button. The Log In screen 
re-appears.

6.	 To make the log in process easier next time, 
select Sign me in automatically, and then 
press the v button.

7.	 Select Log In, and then press the v button. 
The player logs you in to your account. Your 
account e-mail is displayed on the bottom left 
of the screen.

|| NOTEs |
\\ If you selected Sign me in automatically, the next time 

you log in, the player will automatically enter your e-mail 
and password. All you need to do is select Log In.

\\ If your e-mail address and password are not displayed 
when the Log In screen appears, select the button with 
the down pointing arrow head next to the Email field, and 
then press the v button. A drop down list of all your 
registered accounts will appear. Select your account, 
and then press the v button. The player will fill in the 
e-mail and password fields.

\\ If you press the RED (A) button after you have logged 
in, the My Account pop-up appears. On the pop-up, you 
can select Logout, Change account information, Link 
Service Accounts, Remove Accounts from the Device, 
and Deactivate Account.

\\ To rent movies and purchase for-pay apps, you must have 
a credit card registered in your account. If you haven’t 
registered a card, select Change account information. 
On the Change Account information page, select 
Register Card, press the v button, and then follow the 
directions on the screen.

Before Using Movies & TV Shows 
or Apps

If you haven’t set up Smart Hub, when you use 
Movies & TV Show or Apps for the first time, the 
player will ask you to perform the Smart Hub set 
up procedure.
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1.	 On the Home screen, select either Movies & 

TV Shows or Apps, and then press the v 
button. If you have selected Apps, go to Step 4.

2.	 If you selected Movies & TV Shows, the 
Smart Hub pop-up appears asking if you 
want to set up Smart Hub. Select Yes, and 
then press the v button. The Welcome 
screen appears.

3.	 Select Start, and then press the v button. 
The Smart Hub Terms & Conditions, Privacy 
Policy screen appears.

4.	 On the Smart Hub Terms & Conditions, 
Privacy Policy screen, you must review and 
agree to both the Smart Hub Terms and 
Conditions and the Privacy Policy to use 
Smart Hub.

5.	 Scroll down, and then click the View details 
buttons to review the full documents.

6.	 When done reading, scroll up to the first entry 
field, and press the v button to agree to 
the Terms and Conditions and consent to the 
Privacy Policy.

7.	 Press the ► button twice to go to the 
Supplemental Privacy Notices screen.

8.	 Click the View details button to view the 
entire notice.

9.	 When done reading, scroll up to the top entry 
field, and then press the v button.

|| NOTEs |
\\ You do not need to consent to the Supplemental 

Privacy Notice, but one or more Smart TV features or 
functionalities may not be available if you do not.

10.	 Press the ► button twice. The Setup 
Complete screen appears. Press the v 
button.

Using Movies & TV Shows

You can download or stream for pay and free-of-
charge movies and TV shows and view them on 
your TV.

1.	 On the Home screen, select Movies & TV 
Shows, and then press the v button.

2.	 Select one of the Featured or Recommended 
movies, and then press the v button. The 
page for that movie appears.

OR
Use the ▼ button to go to the bottom of the 
screen. Select Favorites, Featured, Movies, 
TV Shows, or Purchased, and then press 
the v button. 
On the page that appears, use the ▲▼◄► 
buttons to select a show or movie, and then 
press the v button.
On the TV Shows or Movies screen, you can 
also select What’s New, Most Popular, 
or Genres to see more available shows 
or movies. On the Genre screen, use the 
▲▼◄► buttons to select a Genre, and then 
press the v button.
To make a selection on a page displaying TV 
shows or movies, use the ▲▼◄► buttons 
to make a selection, and then press the v 
button.

Movies & TV Shows

	 Favorites	 Featured	 Movies	 TV Shows	 Purchased

Featured Recommended
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3.	 To watch a selection, select Watch now, and 
then press the v button. A selection screen 
appears listing various locations from which 
you can rent the film along with prices.

4.	 Select a location, and then press the v 
button. Follow the directions on the screen to 
start the movie.

|| NOTEs |
\\ If you haven't logged into your Samsung account, the Log 

In screen will appear after Step 3 and you will need to log 
in. 

\\ If you don't have a credit card associated with your 
Samsung account, after you log in, the Register Card 
screen will appear. Follow the directions on the screen. 
You must have a credit card registered to your account to 
rent movies and to purchase for-pay apps.

Using Apps

You can download applications from the Internet, 
and access various for pay or free-of-charge 
application and view them on your TV. To access 
some applications, you need to have a Samsung 
account.

The Apps Screen at a Glance

1
Recommended : Displays recommended contents 
managed by Samsung.

2
My Apps : Displays your personal gallery of 
applications modifiable on the More Apps screen.

3

More Apps : Select to access the More Apps 
screen where you can add to, modify, and delete 
applications and see all downloaded applications.

4

Featured Applications : Use the ▲▼◄► buttons 
to highlight the displayed Feature Application, and 
then press the v button. Information about the 
featured application appears.

Downloading Applications
You can download for pay or free-of-charge 
applications through Samsung Apps.
1.	 On the Apps screen, select Samsung Apps, 

and then press the v button. The Samsung 
Apps screen appears.

2.	 Across the top of the screen, under What’s 
New, you'll see a series of new apps. Use 
the ◄► buttons to scroll the list right or left, 
and then select an app. Press the v button 
to see more information about the app. If the 
app is free, select Download, and then press 
the v button to download the app.  
If it is a for pay app, select Buy, press the 
v button, and then follow the instructions 
on the screen.

|| NOTEs |
\\ To buy an app, you must be logged into your Samsung 

account and have a credit card registered to the account. 
Press the RED (A) button on your remote to log in.

\\ If you haven’t registered a card, after you log in, press the 
RED (A) button again, and then select Change Account 
Information in the pop-up that appears. On the Change 
Account information page, select Register Card, press 
the v button, and then follow the directions on the 
screen.

\\ You can also access and download apps from the 
categories listed on the left of the screen. For instructions, 
see Step 4.

TVSamsung
	 2	 3	 4	 5

	 WebBrowser

More Apps

2

3

1
1

Recommended

My Apps

Apps

4
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3.	 After the app has downloaded, select Run, 

and then press the v button to run the app 
now. To run the app later, press the RETURN 
button. In either case, the icon for the app will 
appear on the Apps screen.

4.	 To see additional apps, use the ▲▼◄► 
buttons to move to the category list on the 
left side of the screen.

5.	 Use the ▲▼ buttons to select a category. 
Each time you move the highlight to another 
category, a different set of applications 
appears on the right.

6.	 Use the ► button to move to the applications 
and the ▲▼◄► buttons to move from app 
to app.

7.	 To see more information about an app, select 
it, and then press the v button.

8.	 To download the app, follow the directions in 
Steps 2 and 3.

Starting an Application

1.	 Select Apps on the Home screen, and then 
press the v button.

2.	 On the Apps screen, use the ▲▼◄► buttons 
to select an app, and then press the v 
button. The app starts.

Using the More Apps Screen

The More Apps Screen lists all the apps you have 
downloaded and lets you:
•	 Sort the apps on the More Apps screen by Date 

downloaded, Recently opened, and Title.
•	 Apply a number of Options Menu functions to 

the apps listed in the My Apps section of the 
Apps screen including updating apps, moving 
apps into a folder, deleting the apps from My 
Apps, and locking the apps.

•	 Start apps.

Sorting the Apps
To sort the apps on the More Apps screen, follow 
these steps:
1.	 On the Home screen, select Apps, and then 

press the v button.
2.	 On the Apps screen, use the ▼ button 

to move to the More Apps hotspot at the 
bottom of the page, and then press the v 
button.

3.	 On the More Apps screen, use the ▲► 
buttons to move to View at the top of the 
screen, and then press the v button.

4.	 In the drop down that appears, select Date 
Downloaded, Recently Opened, or Title, 
and then press the v button. The apps 
on the More Apps screen are sorted by the 
criteria you have chosen.

Using the Options Menu Functions

Lock/Unlock
Using the Lock/Unlock function and the Security 
PIN, you can lock applications so they cannot 
be started on either the Apps screen or the More 
Apps screen. The default PIN is 0000.
1.	 On the More Apps screen, use the ▲► 

buttons to go to Options at the top of the 
screen, and then press the v button.

More Apps

	 WebBrowser	 App2	 App3

	 App4	 App5	 App6

	 App7	 App8	 App9

WebBrowser 
Category : Basic  |  Version : X.XXX  |  Size : XX.XKB

Contact Info : admin@samsung.com (If you need to contact us, please use this address.)

      View : Date Downloaded    Options

1 / 9

Storage	

XX MB / XXX  MB
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2.	 Select Lock/Unlock, and then press the v 
button.

3.	 When the Lock service appears, enter the 
PIN using the number buttons on your remote 
control.

4.	 To lock an application, select the application, 
and then press the v button. A lock 
appears on the app. Repeat to lock other, 
individual apps.

5.	 To unlock a locked app, select the 
application, and then press the v button.

6.	 To lock all the apps at once, use the ▲► 
buttons to select the Lock All button, and 
then press the v button.

7.	 To unlock all the locked apps at once, use the 
▲► buttons to select the Unlock All button 
and then press the v button.

8.	 Press the RETURN button twice to return to 
the Apps screen. Locked apps will display a 
lock on the upper right side.

Edit My Apps
Edit My Apps lets you add apps to and delete 
apps from My Apps. It also lets you change the 
position of an app in My Apps.

Add an App to My Apps
1.	 On the More Apps screen, use the ▲► 

buttons to go to Options at the top of the 
screen, and then press the v button.

2.	 Select Edit My Apps, and then press the v 
button. The Edit My Apps screen appears.

3.	 Select a full color app from the top row of 
apps, and then press the v button. The 
full color app icon appears in the My Apps 
area below and the app icon in the top row is 
grayed out.

|| NOTEs |
\\ Grayed out apps are already in My Apps.

4.	 When you return to the Apps screen, the app 
will appear in the My Apps area.

Delete an App from My Apps
1.	 On the More Apps screen, use the ▲► 

buttons to go to Options at the top of the 
screen, and then press the v button.

2.	 Select Edit My Apps, and then press the v 
button. The Edit My Apps screen appears.

3.	 Select the app you want to delete from My 
Apps, press the v button, and then press 
the ▲ button in the direction of the X. The 
Remove from My Apps pop-up appears.

4.	 Select Yes, and then press the v button.
5.	 When you return to the Apps screen, the app 

will have been removed from the My Apps 
area.

Move an App in My Apps
1.	 On the More Apps screen, use the ▲► 

buttons to go to Options at the top of the 
screen, and then press the v button.

2.	 Select Edit My Apps, and then press the v 
button. The Edit My Apps screen appears.

3.	 Select the app you want to move in My Apps, 
press the v button, and then press the 
▲▼◄► button to move the app icon in the 
direction of one of the arrows (<, >, ^, etc.) 
that appears around the app icon. The app 
icon moves in the direction you have chosen.

4.	 After you have placed the app icon where 
you want, press the v button.

5.	 When you return to the Apps screen, the 
app will be positioned in the location you had 
selected.
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Create Folder
Create Folder lets you create a folder on the More 
Apps screen into which you can put apps.
1.	 On the More Apps screen, use the ▲► 

buttons to go to Options at the top of the 
screen, and then press the v button.

2.	 Select Create Folder, and then press the 
v button. The Set Folder Name pop-up 
appears.

3.	 Press the v button. The keyboard appears.
4.	 Select the Clear button on the right side, 

and then press the v button to remove 
Folder 1 from the entry field. Then, using the 
keyboard, enter the name you want to apply 
to the folder.

5.	 When finished, select the Done button on the 
right side, and then press the v button. 
The pop-up reappears.

6.	 Select OK, and then press the v button. 
The new folder appears in the list of apps on 
the left side of the screen.

Move to Folder
Move to Folder lets you move apps to the folder of 
your choice.
1.	 On the More Apps screen, use the ▲► 

buttons to go to Options at the top of the 
screen, and then press the v button.

2.	 Select Move to Folder, and then press 
the v button. The Move to Folder screen 
appears.

3.	 Use the ▲▼◄► buttons to move to an app, 
and then press the v button to select the 
app. A check appears in the upper left corner 
of the app.

4.	 To deselect an app, press the v button. 
The check disappears.

5.	 Repeat Step 3 to select additional apps.

|| NOTEs |
\\ To select all the downloaded apps, select Select All at the 

top right of the screen, and then press the v button. To 
deselect all the apps, select Deselect All at the top right 
of the screen, and then press the v button.

6.	 When done, select Select folder at the top 
of the screen, and then press the v button. 
The Select folder pop-up appears. 

7.	 In the Select folder pop-up, use the ▲▼ 
buttons to select the folder you want to move 
the apps you selected to and then press the 
v button.

8.	 The Apps Moved pop up appears. Press the 
v button.

9.	 To open a folder, use the ▲▼◄► buttons to 
highlight the folder, and then press the v 
button.

Rename Folder
Rename Folder lets you rename an existing folder.
1.	 On the More Apps screen, use the ▲► 

buttons to go to Options at the top of the 
screen, and then press the v button.

2.	 Select Rename Folder, and then press 
the v button. The Rename Folder screen 
appears, and a folder is highlighted.

3.	 User the ▲▼◄► buttons to highlight a 
folder of your choice, and then press the v 
button. The Rename pop-up appears. 

4.	 Press the v button. The keyboard appears.
5.	 Enter the new name for the folder. When 

finished, select Done on the right side, and 
then press the v button. The Rename pop-
up reappears displaying the new name.

6.	 Select OK, and then press the v button. 
The folder is renamed.

7.	 Select Close on the right side of the screen, 
and then press the v button.
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Delete
Delete lets you delete apps and folders from the 
My Apps screen. If there are apps in a folder, 
both the folder and the apps are deleted together. 
Delete removes apps permanently. If you decide 
you want to use an app you deleted, you will need 
to download it again.
1.	 On the More Apps screen, use the ▲► 

buttons to go to Options at the top of the 
screen, and then press the v button.

2.	 Select Delete, and then press the v button. 
The Delete screen appears.

3.	 Use the ▲▼◄► buttons to move to an app, 
or folder and then press the v button to 
select. A check appears in the upper left 
corner of the app or folder you selected.

4.	 To deselect an app, press the v button. 
The check disappears.

5.	 Repeat Step 3 to select additional apps or 
folders.

|| NOTEs |
\\ To select all the downloaded apps, select Select All at the 

top right of the screen, and then press the v button. To 
deselect all the apps, select Deselect All at the top right 
of the screen, and then press the v button.

6.	 After you have made all your selections, 
select Delete at the top of the screen, and 
then press the v button. The Delete pop-
up appears.

7.	 Select Yes, and then press the v button. 
All the apps you selected are deleted.

|| NOTEs |
\\ You cannot immediately delete a locked app or folder. 

If you select a locked app or folder to delete, when you 
perform Step 7, the Lock Service pop-up appears. Enter 
the Security PIN into the pop-up, and then press the v 
button. The lock will be released and the app or folder will 
be deleted. 

Update Apps
When the application require to update to the 
latest version, select Apps and then select More 
Apps. On the More Apps screen, select Update 
Apps, and then select application from the list. 
The application starts updating to the latest 
version. However, Update Apps appears on the 
screen only when the update is required.
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Screen Mirroring

The Screen Mirroring function lets you view the 
screen of your smart phone or android tablet on 
the TV you have connected to the Blu-ray player.
1.	 With the Blu-ray's Home screen displayed, 

press the BLUE (D) button on the remote. 
The Screen Mirroring pop-up appears.

2.	 Launch AllShare Cast on your device.
3.	 On your device, find the name of the Blu-ray 

player in the list of available devices and then 
select it.

4.	 The TV will display a PIN. Enter the PIN into 
your device.

5.	 The TV displays a connecting message (for 
example, Connecting to Android_92gb...) and 
then displays the connected message.

6.	 In a few moments, the screen of your device 
appears on the TV screen.

7.	 To stop Screen Mirroring, press the EXIT 
or RETURN button on the remote control, 
or disable Screen Mirroring function of your 
smart phone.

|| NOTEs |
\\ You can connect to a device that supports AllShare Cast. 

Note that connecting to such a device may not be fully 
supported depending on the manufacturer. For further 
information on mobile connection support, refer to the 
manufacturer’s web site.

\\ When you are using the Screen Mirroring function, video 
stuttering or audio dropouts may occur, depending on 
your environment.

\\ Bluetooth transmissions can interfere with the Screen 
Mirroring signal. Before using the Screen Mirroring 
function, we strongly recommend that you turn off the 
Bluetooth function on your smart phone or smart device 
(tablet, etc.).

Using the Web Browser

You can access the Internet using the Web 
Browser application.
Select Web Browser on the Home screen, and 
then press the v button.

|| NOTEs |
\\ When you run the Web Browser with the player connected 

by HDMI to a BD Wise compatible TV - and BD Wise is on 
- the browser is maximized to fill the screen and the TV's 
resolution is set to the optimal resolution automatically. 

\\ The Web Browser is not compatible with Java 
applications.

\\ If you attempt to download a file, and the file cannot be 
saved, an error message will appear.

\\ E-commerce (purchasing products online) is not 
supported.

\\ ActiveX is not supported.
\\ Access may be blocked to some websites or to web 

browsers operated by certain businesses.

Link Browsing and Pointer Browsing
The Web Browser provides two types of browsing, 
Pointer Browsing and Link Browsing. When you 
launch the browser for the first time, Pointer 
Browsing is active. If you are using a mouse to 
navigate in the Web Browser, we recommend 
leaving Pointer Browsing active. If you are using 
your remote to navigate in the Web Browser, we 
recommend that you replace Pointer Browsing 
with Link Browsing. Link Browsing moves a 
highlight from one link to the next in the Web 
Browser and is much faster than Pointer Browsing 
if you are using your remote.
To activate Link Browsing, follow these steps:
1.	 Use the ▲▼◄► buttons on your remote to 

move the pointer to the Link Browser icon on 
the top right of the screen. The Link Browser 
icon is the third icon from the right. 
The pointer will be in the correct position 
if the icon turns blue and the words “Link 
Browsing” appear on the screen.

2.	 Press the v button. Link Browsing is 
activated and will remain active whenever you 
bring up the Web Browser.
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The Control Panel at a Glance
The Control Panel, which runs across the top 
of the screen, has a series of icons which start 
a number of useful functions. The icons are 
described below, starting with the icon on the far 
left of the screen.

1

•	  : Moves to the previous page.
•	  : Moves to the next web page.
•	  : Displays the Bookmarks and History screen. 

You can bookmark the current page, select 
an existing bookmark, and edit and delete 
bookmarks. You can also view your browsing 
history and select a page to revisit.

•	  : Moves to the Home screen of the Web 
Browser.

•	 http://www.samsung.com  : Lets you enter a page 
address manually using the keyboard pop-up.

•	  : Reloads the current page so that it is 
refreshed on the screen.

•	  : Adds the current page to your bookmarks.
•	  : Lets you search for information 

by entering words or characters using the 
keyboard pop-up. See Using the Keyboard Pop-
up on page 55.

•	  : Lets you enlarge or shrink the screen 
by various percentages.

•	  /  : Lets you switch between Pointer 
Browsing and Link Browsing.

•	  : Lets you configure the Browser’s settings. 
See Using the Settings Menu on page 56.

•	  : Closes the Web Browser.

Using the Keyboard Pop-up 
When you click the http://www.samsung.com , the 

 or access a data or text entry field, 
and then press the v button, the keyboard pop-
up appears.
To use the keyboard pop-up with your remote, 
follow these steps:

1.	 Use the ▲▼◄► buttons on your remote to 
move the highlight to a letter or number of 
your choice.

2.	 Press the v button to enter the letter or 
number into the entry field.

3.	 To access capital letters, move the highlight 
to the Caps key on the top left, and then 
press the v button. Press the v button 
again with the Caps key highlighted to 
access small letters again.

4.	 To access symbols and additional punctuation 
marks, highlight the 123#& button on the left, 
and then press the v button.

5.	 To delete a character you entered, move the 
highlight to the : button, and then press the 
v button.

6.	 To delete all the characters you entered, 
move the highlight to the Clear button, and 
then press the v button.

7.	 When finished entering, move the highlight 
to the Done button, and then press the v 
button.

100%http://www.samsung.com

	 Caps	 1	 2	 3	 4	 5	 6	 7	 8	 9	 0	 :	 Clear

	 q	 w	 e	 r	 t	 y	 u	 i	 o	 p	 ^	 *	 

	 123#&	 a	 s	 d	 f	 g	 h	 j	 k	 l	 ~	 @	 !	 Done

	 z	 x	 c	 v	 b	 n	 m	 ,	 .	 ?	 -	 	 Cancel

	 ENG		  www.	 .com	 /	 	 	 

As you enter characters, recommended text will be shown.

1

100%http://www.samsung.com
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|| NOTEs |
\\ If you have a wireless keyboard connected to your 

player, you can use the wireless keyboard to enter 
letters, numbers, symbols, and punctuation. Note that 
the wireless keyboard will work only when the keyboard 
popup appears and can only be used to enter letters, 
numbers, symbols, and punctuation.

Options on the Keyboard Pop-Up 
To access the keyboard pop-up options, highlight 
the  button on the bottom left of the keyboard, 
and then press the v button.

Language
Select the language for the keyboard. 
You can select English, French, 
Russian, etc.

Recommended 
Text

The keyboard will suggest 
recommended words as you enter text. 
You can turn this function On or Off.

Predict Next 
Letter

The keyboard will predict the next letter 
as you enter letters. The predictions 
appear in a ring around the letter you 
have just entered. You can select a 
predicted letter or move to another 
letter. You can turn this function On or 
Off.

Using the Setting Menu
The Setting menu contains functions that control 
how the Browser operates and Browser security 
functions. To open the Setting menu, highlight 
the  icon in the Control Panel, and then press 
the v button. To select an option in the setting 
menu, highlight the option, and then press the v 
button.

Enable/Disable 
Grabbing

Turns the Grabber function on and off. 
When the Grabber function is on, you 
can move a web page up and down 
without dragging the scroll bar. 
The Grabber function is only available 
in Pointer Browsing.

Approved Sites

Lets you restrict your children’s access 
to inappropriate web pages by allowing 
access only to the web sites you have 
registered. 
Every time you access this function, the 
PIN screen appears. The first time you 
access this function, enter the default 
PIN, 0000 using the number buttons 
on your remote.
You can change the PIN using the 
Reset password for the Approved Sites 
function. See below.
Approved Sites Feature : Turns the 
Approved Sites function on or off.
Reset password for Approved Sites : 
Change the Approved Sites password.
Add current site : Lets you add the 
currently displayed web site to the 
Approved Sites list.
Manage Approved Sites : Lets you 
key in URLs to add to the Approved 
Sites List and delete sites from the 
Approved Sites list.
If you turn this function on and have 
not added any sites to the Approved 
Sites list, you will not be able to access 
any Internet sites.

100%http://www.samsung.com

Enable Grabbing
Approved Sites
Private browsing On
Web Browser Settings
Help

Close
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Private 
Browsing On/Off

Enable or disable the Privacy mode.
When the Privacy mode is enabled, 
the browser does not retain the URLs 
of sites you visit. If you want to enable 
Privacy mode, select OK.
If the Privacy mode is running, the 
“Stop” icon appears in front of the URL 
at the top of the screen. To disable 
Privacy mode, select it again when 
Privacy mode is enabled.

Web Browser 
Setting

Set as homepage : You can set the 
Browser's home page.
Pop-up Block : Turns the Popup Block 
on and off.
Ad Block : You can determine whether 
to block advertisements and select the 
URLs for which advertisements are 
blocked.
General : You can delete personal 
information such as website history 
and browsing data (cookies, etc.), and 
reset all web browser settings to their 
factory defaults.
Encoding : You can set the Encoding 
setting for web pages to Automatic or 
select the encoding format manually 
from a list.
Pointer : You can set the speed of the 
cursor when the cursor is set to Pointer 
and turn Smart Cursor On and Off.
Browser Information : Displays 
the version number and copyright 
information for the Web Browser.

Help Provides basic information about the 
operation of the Web Browser.

|| NOTEs |
\\ Depending on the web site, some of the Web Browser 

Setting functions may not be activated. Functions that are 
not activated are greyed out and cannot be used. 

Linking Your Internet Service 
Accounts to the Player

The Link Service Accounts function lets you link 
your player to your accounts with Internet services 
such as Pandora so that the player can log you 
in to the service automatically when you start the 
app for that service.
To create a service account link, follow these 
steps:
1.	 On the Home screen, press the RED (A) 

button on your remote to log in to your 
Samsung Account.

2.	 After you have logged in, press the RED (A) 
button on your remote again.

3.	 Select Link Service Accounts in the My 
Account pop-up, and then press the v 
button.

4.	 On the Link Service Accounts screen, select 
the service you want to link to the player, and 
then press the v button.

5.	 Select Register, and then press the v 
button.

6.	 In the ID and Password screen, enter the ID 
you use to log in to the service you selected 
using the pop-up keyboard. When finished, 
select Done, and then press the v button.

7.	 Repeat the same process for the password. 
When finished select Done, and then press 
the v button.

8.	 Select OK, and then press the v button.
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BD-LIVE™

Once the player is connected to your network, you 
can enjoy various movie-related service contents 
available on BD-LIVE compliant discs.
1.	 Attach a USB flash memory drive to the 

USB jack on the front of the player, and then 
check its remaining memory. The memory 
device must have at least 1GB of free space 
to accommodate the BD-LIVE services.

2.	 Select Settings on the Home screen, and 
then press the v button.

3.	 Select Network, and then press the v 
button.

4.	 Select BD-Live Settings, and then press the 
v button.

5.	 Select BD Data Management, and then 
press the v button.

6.	 Select Select Device, and then press the 
v button.

7.	 Select USB device, and then press the v 
button.

8.	 Insert a Blu-ray Disc that supports BD-LIVE.
9.	 Select an item from the list of BD-LIVE service 

contents provided by the disc manufacturer.
|| NOTEs |
\\ The way you use BD-LIVE and the provided contents may 

differ, depending on the disc manufacturer.
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Appendix
Compliance and Compatibility Notice

NOT ALL discs are compatible
•	 Subject to the restrictions described below and those noted throughout this Manual, including the Disc 

Type and Characteristics section of this user manual, disc types that can be played are: pre-recorded 
commercial BD-ROM, DVD-VIDEO, and Audio CD (CD-DA); BD-RE/-R, DVD-RW/-R; and CD-RW/-R. 

•	 Discs other than the above cannot and/or are not intended to be played by this player. And some of 
the above discs may not play due to one or more reasons provided below.

•	 Samsung cannot assure that this player will play every disc bearing the BD-ROM, BD-RE/-R,  
DVD-VIDEO, DVD-RW/-R, DVD+RW/+R and CD-RW/-R logos, and this player may not respond to 
all operating commands or operate all features of every disc. These and other disc compatibility and 
player operation issues with new and existing format discs are possible because:
-- Blu-ray is a new and evolving format and this player may not operate all features of Blu-ray Discs 

because some features may be optional, additional features may have been added to the Blu-ray  
Disc format after the production of this player, and certain available features may be subject to 
delayed availability;

-- not all new and existing disc format versions are supported by this player;
-- new and existing disc formats may be revised, changed, updated, improved and/or supplemented;
-- some discs are produced in a manner that allows specific or limited operation and feature during 

playback;
-- some features may be optional, additional features may have been added after the production of this 

player or certain available features may be subject to delayed availability;
-- some discs bearing the BD-ROM, BD-RE/-R, DVD-VIDEO, DVD-RW/-R, DVD+RW/+R and  

CD-RW/-R logos may still be non-standardized discs;
-- some discs may not be played depending on their physical state or recording conditions;
-- problems and errors can occur during the creation of Blu-ray Disc, DVD software and/or the 

manufacture of discs;
-- this player operates differently than a standard DVD player or other AV equipment; and/or
-- for reasons noted throughout this user manual and for other reason(s) discovered and posted by 

SAMSUNG customer care center.
•	 If you encounter disc compatibility or player operation problems, please contact SAMSUNG customer 

care center.  
You may also contact SAMSUNG customer care center for possible updates on this player.

•	 For additional information on playback restrictions and disc compatibility, refer to the Precautions, 
Before Reading the user manual, Disc Types and Characteristics, and Before Playing sections of this 
user manual.

•	 For Blu-ray Disc Player progressive scan output : CONSUMERS SHOULD NOTE THAT NOT 
ALL HIGH DEFINITION TELEVISION SETS ARE FULLY COMPATIBLE WITH THIS PRODUCT AND 
MAY CAUSE ARTIFACTS TO BE DISPLAYED IN THE PICTURE. IN CASE OF PROGRESSIVE SCAN 
PICTURE PROBLEMS, IT IS RECOMMENDED THAT THE USER SWITCH THE CONNECTION TO 
THE 'STANDARD DEFINITION' OUTPUT. IF THERE ARE QUESTIONS REGARDING OUR TV SET 
COMPATIBILITY WITH THIS PRODUCT, PLEASE CONTACT OUR CUSTOMER SERVICE CENTER.
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Copy Protection

•	 Because AACS (Advanced Access Content System) is approved as content protection system for  
Blu-ray Disc format, similar to use of CSS (Content Scramble System) for DVD format, certain 
restrictions are imposed on playback, analog signal output, etc., of AACS protected contents.  
The operation of this product and restrictions on this product may vary depending on your time of 
purchase as those restrictions may be adopted and/or changed by AACS after the production of this 
product. Furthermore, BD-ROM Mark and BD+ are additionally used as content protection system for 
Blu-ray Disc format, which imposes certain restrictions including playback restrictions for BD-ROM 
Mark and/or BD+ protected contents. To obtain additional information on AACS, BD-ROM Mark, BD+, 
or this product, please contact SAMSUNG customer care center.

•	 Many Blu-ray Disc/DVDs are encoded with copy protection. Because of this, you should only connect 
your Player directly to your TV, not to a VCR. Connecting to a VCR results in a distorted picture from 
copy-protected Blu-ray Disc/DVDs.

•	 Under the U.S. Copyright laws and Copyright laws of other countries, unauthorized recording, use, 
display, distribution, or revision of television programs, videotapes, Blu-ray Discs, DVDs, and other 
materials may subject you to civil and/or criminal liability.

•	 Cinavia Notice : This product uses Cinavia technology to limit the use of unauthorized copies of 
some commercially-produced film and videos and their soundtracks. When a prohibited use of 
an unauthorized copy is detected, a message will be displayed and playback or copying will be 
interrupted. 
More information about Cinavia technology is provided at the Cinavia Online Consumer Information 
Center at http://www.cinavia.com. To request additional information about Cinavia by mail, send a 
postcard with your mailing address to: Cinavia Consumer Information Center, P.O. Box 86851, San 
Diego, CA, 92138, USA. 
This product incorporates proprietary technology under license from Verance Corporation and is 
protected by U.S. Patent 7,369,677 and other U.S. and worldwide patents issued and pending as well 
as copyright and trade secret protection for certain aspects of such technology. Cinavia is a trademark 
of Verance Corporation. Copyright 2004-2010 Verance Corporation. All rights reserved by Verance. 
Reverse engineering or disassembly is prohibited.

Network Service Disclaimer

All content and services accessible through this device belong to third parties and are protected by 
copyright, patent, trademark and/or other intellectual property laws. Such content and services are 
provided solely for your personal noncommercial use. You may not use any content or services in a 
manner that has not been authorized by the content owner or service provider. Without limiting the 
foregoing, unless expressly authorized by the applicable content owner or service provider, you may 
not modify, copy, republish, upload, post, transmit, translate, sell, create derivative works, exploit, or 
distribute in any manner or medium any content or services displayed through this device.
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THIRD PARTY CONTENT AND SERVICES ARE PROVIDED "AS IS." SAMSUNG DOES NOT WARRANT 
CONTENT OR SERVICES SO PROVIDED, EITHER EXPRESSLY OR IMPLIEDLY, FOR ANY PURPOSE. 
SAMSUNG EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES, INCLUDING BUT NOT LIMITED 
TO, WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. SAMSUNG 
DOES NOT GUARANTEE THE ACCURACY, VALIDITY, TIMELINESS, LEGALITY, OR COMPLETENESS 
OF ANY CONTENT OR SERVICE MADE AVAILABLE THROUGH THIS DEVICE AND UNDER NO 
CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL SAMSUNG BE LIABLE, WHETHER IN 
CONTRACT OR TORT, FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL 
DAMAGES, ATTORNEY FEES, EXPENSES, OR ANY OTHER DAMAGES ARISING OUT OF, OR IN 
CONNECTION WITH, ANY INFORMATION CONTAINED IN, OR AS A RESULT OF THE USE OF ANY 
CONTENT OR SERVICE BY YOU OR ANY THIRD PARTY, EVEN IF ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES.
Third party services may be terminated or interrupted at any time, and Samsung makes no representation 
or warranty that any content or service will remain available for any period of time. Content and services 
are transmitted by third parties by means of networks and transmission facilities over which Samsung 
has no control. Without limiting the generality of this disclaimer, Samsung expressly disclaims any 
responsibility or liability for any interruption or suspension of any content or service made available 
through this device. 
Samsung is neither responsible nor liable for customer service related to the content and services. 
Any question or request for service relating to the content or services should be made directly to the 
respective content and service providers.

License

•	 Manufactured under license from Dolby Laboratories. Dolby and the double-D symbol 
are registered trademarks of Dolby Laboratories.

•	 Manufactured under license under U.S. Patent Nos: 5,956,674; 5,974,380; 
6,226,616; 6,487,535; 7,212,872; 7,333,929; 7,392,195; 7,272,567 & other U.S. 
and worldwide patents issued & pending. DTS-HD, the Symbol, & DTS-HD and the 
Symbol together are registered trademarks & DTS-HD Master Audio is a trademark of 
DTS, Inc. Product includes software. © DTS, Inc. All Rights Reserved.

•	 The terms HDMI and HDMI High-Definition Multimedia Interface, and the HDMI 
Logo are trademarks or registered trademarks of HDMI Licensing LLC in the United 
States and other countries.

•	 Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names 
may be trademarks of their respective owners.

•	 Open Source License Notice
-- In the case of using open source software, Open Source Licenses are available on the product 

menu.

•	 Blu-ray Disc™, Blu-ray™ and the logos are trademarks of the Blu-ray Disc Association.
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Additional Information 

Notes

Settings

3D Settings

•	 For some 3D discs, to stop a movie during 3D playback, press the 5 (STOP) button once. The 
movie stops and the 3D mode option is de-activated. 
To change a 3D option selection when you are playing a 3D movie, press the 5 (STOP) button 
once. The Home screen menu appears. Press the 5 (STOP) button again, then select 3D 
Settings in the Blu-ray menu.

•	 Depending on the content and the position of the picture on your TV screen, you may see vertical 
black bars on the left side, right side, or both sides.

TV Aspect Ratio

•	 Depending on the disc type, some aspect ratios may not be available.
•	 If you select an aspect ratio and option that is different than the aspect ratio of your TV screen, 

the picture might appear to be distorted.
•	 If you select the 16:9 Original, your TV may display 4:3 Pillarbox (black bars on sides of picture).

BD Wise (Samsung Players only)

•	 When BD Wise is on, the Resolution setting automatically defaults to BD Wise and BD Wise 
appears in the Resolution menu.

•	 If the player is connected to a device that does not support BD Wise, you can not use the BD 
Wise function.

•	 For proper operation of BD Wise, set the BD Wise option of both the player and the TV to On.

Digital Output

•	 Be sure to select the correct Digital Output or you will hear no sound or just loud noise.
•	 If the HDMI device (AV receiver, TV) is not compatible with compressed formats (Dolby Digital, 

DTS), the audio signal outputs as PCM.
•	 Regular DVDs do not have BONUSVIEW audio and Navigation Sound Effects.
•	 Some Blu-ray Discs do not have BONUSVIEW audio and Navigation Sound Effects.
•	 This Digital Output setup does not affect the HDMI audio output to your TV. 

It affects the optical and HDMI audio output when your player is connected to an AV receiver.
•	 If you play MPEG audio soundtracks, the audio signal outputs as PCM regardless of your Digital 

Output selections (PCM or Bitstream).

PCM Downsampling

•	 Even when PCM Downsampling is set to Off, some discs will only output downsampled audio 
through the optical digital output.

•	 HDMI
-- If your TV is not compatible with compressed multi-channel formats (Dolby Digital, DTS), the 

player may output PCM 2ch downmixed audio even though you selected Bitstream (either 
Reencoded or Unprocessed) in the setup menu.

-- If your TV is not compatible with PCM sampling rates over 48kHz, the player may output 
48kHz.
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Settings

BD-LIVE Internet Connection

•	 What is a valid certificate? 
When the player uses BD-LIVE to send the disc data and a request to the server to certify the 
disc, the server uses the transmitted data to check if the disc is valid and sends the certificate 
back to the player.

•	 The Internet connection may be restricted while you are using BD-LIVE contents.

BD Data Management

•	 In the external memory mode, disc playback may be stopped if you disconnect the USB device in 
the middle of playback.

•	 Only those USB devices formatted in the FAT file system (DOS 8.3 volume label) are supported.  
We recommend you use USB devices that support USB 2.0 protocol with 4 MB/sec or faster 
read/write speed.

•	 The Resume Play function may not work after you format the storage device.
•	 The total memory available to BD Data Management may differ, depending on conditions.

Anynet+ (HDMI-CEC)

•	 Depending on your TV, certain HDMI output resolutions may not work. Please refer to the user 
manual of your TV.

•	 This function is not available if the HDMI cable does not support CEC.
•	 If your Samsung TV has an Anynet+ logo, then it supports the Anynet+ function.

Media Play

Selecting the Audio Language

•	 The ◄► indicator will not appear on the screen if the BONUSVIEW section does not contain any 
BONUSVIEW audio settings.

•	 The languages available through the Audio Language function depend on the languages that are 
encoded on the disc. This function or certain languages may not be available.

•	 Some Blu-ray Discs may allow you to select either the PCM or Dolby Digital audio soundtrack in 
English.

Selecting the Subtitle Language

•	 Depending on the Blu-ray Disc / DVD, you may be able to change the subtitle language in the 
Disc Menu. Press the DISC MENU button.

•	 This function depends on the selection of subtitles that are encoded on the disc and may not be 
available on all Blu-ray Discs/DVDs.

•	 Information about the main feature BONUSVIEW mode will also appear if the Blu-ray Disc has a 
BONUSVIEW section.

•	 This function changes both the primary and secondary subtitles at the same time.
•	 The total number of primary and secondary subtitles are displayed respectively.
•	 If you press the SUBTITLE button on the remote control, the subtitle bar appears. 

Press the RETURN button to remove the subtitle bar.
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Resolution according to the contents type

Contents Type 
Setup Blu-ray Disc E-contents/ 

Digital contents
BD Wise Resolution of Blu-ray Disc 1080p@60F

Auto Movie Frame : Auto UHD Output : Auto 2160p@24F 2160p@24F
UHD Output : Off 1080p@24F 1080p@24F

Movie Frame : Off Max. Resolution of TV input Max. Resolution of TV input
Movie Frame : Auto (24Fs) 
※ 1080p & 1080i only 1080p@24F 1080p@24F

1080p 1080p@60F 1080p@60F
1080i 1080i 1080i
720p 720p 720p
480p 480p 480p

Contents Type 
Setup DVD

BD Wise 480i

Auto Movie Frame : Auto DVD 24Fs Conversion : Auto UHD Output : Auto 2160p@24F
UHD Output : Off 1080p@24F

DVD 24Fs Conversion : Off Max. Resolution of TV input
Movie Frame : Off Max. Resolution of TV input

Movie Frame : Auto (DVD 24Fs Conversion : Auto ) 
※ 1080p & 1080i only 1080p@24F

1080p 1080p@60F
1080i 1080i
720p 720p
480p 480p

|| NOTEs |
\\ If the TV you connected to the player does not support Movie Frame or the resolution you selected, the message "If no 

pictures are shown after selecting 'Yes', please wait for 15 seconds to return to the previous resolution. Do you want to 
change the resolution?" appears. If you select Yes, the TV's screen will go blank for 15 seconds, and then the resolution will 
revert to the previous resolution automatically.

\\ If the screen stays blank after you have changed the resolution, remove all discs, and then press and hold the @ button on 
the top of the player for more than 5 seconds. The initialization message appears on the screen, and the power will turn off 
automatically. When you turn your product on again, all the settings will be reset. Run the Initial Settings procedure again. 
Then, go to Settings > Display > Resolution in the Menu, and select the correct resolution for your TV.

\\ When you run the Initial Settings procedure, re-select the language and aspect ratio (screen size and format) only. Resetting 
does not affect your network settings, so you should be able to skip Network Setup and Software Update.

\\ When the factory default settings are restored, all stored user BD data will be deleted.
\\ The Blu-ray Disc must have the 24 frame feature for the player to use the Movie Frame (24Fs) mode.
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Digital Output Selection

Setup PCM Bitstream  
(Unprocessed)

Bitstream  
(Re-encoded 

DTS)

Bitstream 
 (Re-encoded 

Dolby D)

Connection
HDMI 

supported 
AV receiver

Optical
HDMI 

supported 
AV receiver

Optical

HDMI 
supported AV 
receiver or 

Optical

HDMI supported 
AV receiver or 

Optical

Audio Stream 
on Blu-ray 

Disc

PCM Up to PCM 
7.1ch PCM 2ch PCM PCM 2ch DTS re-encoded Re-encoded 

Dolby Digital *

Dolby Digital Up to PCM 
7.1ch PCM 2ch Dolby Digital Dolby Digital DTS re-encoded Re-encoded 

Dolby Digital *
Dolby Digital 

Plus
Up to PCM 

7.1ch PCM 2ch Dolby Digital 
Plus Dolby Digital DTS re-encoded Re-encoded 

Dolby Digital *

Dolby TrueHD Up to PCM 
7.1ch PCM 2ch Dolby TrueHD Dolby Digital DTS re-encoded Re-encoded 

Dolby Digital *

DTS Up to PCM 
6.1ch PCM 2ch DTS DTS DTS re-encoded Re-encoded 

Dolby Digital *
DTS-HD High 

Resolution 
Audio

Up to PCM 
7.1ch PCM 2ch

DTS-HD High 
Resolution 

Audio
DTS DTS re-encoded Re-encoded 

Dolby Digital *

DTS-HD 
Master Audio

Up to PCM 
7.1ch PCM 2ch DTS-HD 

Master Audio DTS DTS re-encoded Re-encoded 
Dolby Digital *

Audio Stream 
on DVD

PCM PCM 2ch PCM 2ch PCM 2ch PCM 2ch PCM 2ch PCM 2ch

Dolby Digital Up to PCM 
5.1ch PCM 2ch Dolby Digital Dolby Digital Dolby Digital Dolby Digital

DTS Up to PCM 
6.1ch PCM 2ch DTS DTS DTS DTS

Definition for 
Blu-ray Disc Any

Decodes the main feature 
audio and BONUSVIEW 
audio stream together 

into PCM audio and adds 
Navigation Sound Effects.

Outputs only the main 
feature audio stream so that 
your AV receiver can decode 

the audio bitstream. 
You will not hear 

BONUSVIEW audio or 
Navigation Sound Effects.

Decodes the main 
feature audio 

and BONUSVIEW 
audio stream 

together into PCM 
audio and adds 

Navigation Sound 
Effects, then re-

encodes the PCM 
audio into DTS 

bitstream.

Decodes the main 
feature audio and 
BONUSVIEW audio 
stream together 

into PCM audio and 
adds Navigation 
Sound Effects, 

then re-encodes 
the PCM audio 

into Dolby Digital 
bitstream or PCM.

*	 If the Source Stream is 2ch or mono, "Re-encoded Dolby D" Settings are not applied. Output will be 
PCM 2ch.

Blu-ray Discs may include three audio streams :
-- Main Feature Audio : The audio soundtrack of the main feature.
-- BONUSVIEW audio : An additional soundtrack such as the director or actor's commentary.
-- Navigation Sound Effects : When you choose some menu navigation, Navigation Sound Effects may 

sound. Navigation Sound Effects are different on each Blu-ray Disc.
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Troubleshooting

Before requesting service, please try the following solutions.

PROBLEM SOLUTION

No operation can be performed with the 
remote control.

•	 Check the batteries in the remote control. They may need replacing.
•	 Operate the remote control at a distance of no more than 20 feet from the 

player.
•	 Remove the batteries and hold down one or more buttons for several 

minutes to drain the microprocessor inside the remote control to reset it. 
Reinstall the batteries and try to operate the remote control again.

The disc does not play. •	 Ensure that the disc is installed with the label side facing up.
•	 Check the region number of the Blu-ray Disc/DVD.

The disc Menu does not appear. •	 Ensure that the disc has disc menus.

The prohibition message appears on the 
screen.

•	 This message appears when an invalid button is pressed.
•	 The Blu-ray Disc/DVD's software doesn't support the feature (e.g., angles).
•	 You've requested a title or chapter number or search time that is out of 

range.

Play mode differs from the Setup Menu 
selection.

•	 Some of the functions selected in the Setup Menu may not work properly if 
the disc is not encoded with the corresponding function.

The screen ratio cannot be changed. •	 The Screen Ratio is fixed on your Blu-ray Disc/DVD.
•	 This is not a problem with the player.

No audio. •	 Make sure you have selected the correct Digital Output in the Audio Options 
Menu.

The screen is blank. •	 If the HDMI output is set to a resolution your TV cannot support (for 
example, 1080p), you may not see a picture on your TV.

•	 Press the @ button (on top panel) for more than 5 seconds with no disc 
inside. The initialization message appears on the screen, and the power will 
turn off automatically. When you turn your product on again, all the settings 
will be reset.

•	 When the factory default settings are restored, all stored user BD data will 
be deleted.

Forgot password. •	 Press the @ button (on top panel) for more than 5 seconds with no disc 
inside. The initialization message appears on the screen, and the power will 
turn off automatically. When you turn your product on again, all the settings 
will be reset.  
Don't use this unless absolutely necessary.

•	 When the factory default settings are restored, all stored user BD data will 
be deleted.

| 66  English



07
Appendix

PROBLEM SOLUTION

The picture is noisy or distorted. •	 Make sure that the disc is not dirty or scratched.
•	 Clean the disc.

No HDMI output. •	 Check the connection between the TV and the HDMI jack of the player.
•	 Check if your TV supports the 480p, 720p, 1080i or 1080p HDMI input 

resolution.

Abnormal HDMI output screen. •	 If random noise appears on the screen, it means that TV does not support 
HDCP (High-bandwidth Digital Content Protection).

If you experience other problems. •	 Go to the table of contents and find the section of the user manual that 
contains information about the feature you are having the problem with, 
and then follow the procedure again.

•	 If you still cannot resolve the problem, please contact your nearest 
Samsung authorized service center.

AllShare function

I can see folders shared through AllShare, 
but I cannot see the files.

•	 AllShare only shows Video, Photo, and Music files. Other types of files are 
not displayed.

The video plays intermittently. •	 Check if the network is stable. 
•	 Check if the network cable is properly connected and if the network is not 

overloaded. 
•	 The wireless connection between the AllShare compatible device and the 

player is unstable. 
Check the connection.

The AllShare connection between the player 
and the PC is unstable.

•	 IP addresses within the same subnetwork should be unique.  
If they are not, IP interference can cause this phenomenon. 

•	 Check if you have a firewall enabled. 
If so, disable the firewall function.
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PROBLEM SOLUTION

BD-LIVE

I cannot connect to the BD-LIVE server. •	 Test whether the network connection is working using the Network Status 
function. (See page 25)

•	 Check whether a USB memory device is connected to the player.
•	 The memory device must have at least 1GB of free space to accommodate 

the BD-LIVE service. 
You can check the available size in BD Data Management. (See page 25)

•	 See if the BD-LIVE Internet Connection option is set to Allow(All). 
•	 If all above fails, contact the contents provider or update to the player to the 

latest firmware.

When using the BD-LIVE service, an error 
occurs.

•	 The memory device must have at least 1GB of free space to accommodate 
the BD-LIVE service. 
You can check the available size in BD Data Management. (See page 25)

|| NOTEs |
\\ When the factory default settings are restored, all stored user BD data will be deleted.

Repairs
If you contact us to repair your player, an administration fee may be charged if either:
1.	 An engineer is called out to your home at your request and there is no defect in the product.
2.	 You bring the unit to a repair center and there is no defect in the product.
We will provide you with the amount of the administration fee before we make a home visit or begin any 
work on your player. 
We recommend you read this manually thoroughly, search for a solution on line at www.samsung.com, or 
contact Samsung Customer Care at 1-800-SAMSUNG (726-7864) before seeking to repair your player.
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Specifications

General

Power Requirements AC110-120V 50/60Hz
Power Consumption 22W
Weight 3.74 Ibs
Dimensions 16.9 (W) X 7.9 (D) X 1.8 (H) inches
Operating Temperature Range +41°F to +95°F
Operating Humidity Range 10 % to 75 %

USB Type A USB 2.0
DC output 5V 500mA Max.

HDMI Video 2D : 2160p, 1080p, 1080i, 720p, 480p 
3D : 1080p, 720p

Audio PCM, Bitstream 

Audio Output 7.1 Channel Front Left/Front Right, Center, Subwoofer, Surround Left/
Surround Right, Surround Back Left/Surround Back Right

Digital Audio Output Optical

Network

Ethernet 100BASE - TX Terminal
Wireless LAN Built-in

Security 
WEP (OPEN/SHARED) 
WPA-PSK (TKIP/AES) 
WPA2-PSK (TKIP/AES)

WPS(PBC) Supported

•	 Network speeds equal to or below 10Mbps are not supported. 
•	 Design and specifications are subject to change without prior notice.
•	 Weight and dimensions are approximate.
•	 Dispose unwanted electronics through an approved recycler. 

To find the nearest recycling location, go to our website: www.samsung.com/recyclingdirect or call, (877) 
278 - 0799.
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LIMITED WARRANTY TO ORIGINAL PURCHASER
This SAMSUNG brand product, as supplied and distributed by SAMSUNG and delivered new, in the original carton to the 
original consumer purchaser, is warranted by SAMSUNG against manufacturing defects in materials and workmanship for 
a limited warranty period of:

One (1) Year Parts and Labor* 
(*90 Days Parts and Labor for Commercial Use)

This limited warranty begins on the original date of purchase, and is valid only on products purchased and used in the 
United States. To receive warranty service, the purchaser must contact SAMSUNG for problem determination and service 
procedures. Warranty service can only be performed by a SAMSUNG authorized service center. The original dated bill 
of sale must be presented upon request as proof of purchase to SAMSUNG or SAMSUNG's authorized service center. 
Transportation of the product to and from the service center is the responsibility of the purchaser.

SAMSUNG will repair or replace this product, at our option and at no charge as stipulated herein, with new or reconditioned 
parts or products if found to be defective during the limited warranty period specified above. All replaced parts and 
products become the property of SAMSUNG and must be returned to SAMSUNG. Replacement parts and products 
assume the remaining original warranty, or ninety (90) days, whichever is longer.

SAMSUNG's obligations with respect to software products distributed by SAMSUNG under the SAMSUNG brand name 
are set forth in the applicable end user license agreement. Non-SAMSUNG hardware and software products, if provided, 
are on an "AS IS" basis. 
Non-SAMSUNG manufacturers, suppliers, publishers, and service providers may provide their own warranties.

This limited warranty covers manufacturing defects in materials and workmanship encountered in normal, and except to 
the extent otherwise expressly provided for in this statement, noncommercial use of this product, and shall not apply to the 
following, including, but not limited to: damage which occurs in shipment; delivery and installation; applications and uses 
for which this product was not intended; altered product or serial numbers; cosmetic damage or exterior finish; accidents, 
abuse, neglect, fire, water, lightning or other acts of nature; use of products, equipment, systems, utilities, services, parts, 
supplies, accessories, applications, installations, repairs, external wiring or connectors not supplied and authorized by 
SAMSUNG, or which damage this product or result in service problems; incorrect electrical line voltage, fluctuations and 
surges; customer adjustments and failure to follow operating instructions, cleaning, maintenance and environmental 
instructions that are covered and prescribed in the instruction book; product removal or reinstallation; reception problems 
and distortion related to noise, echo, interference or other signal transmission and delivery problems. SAMSUNG does not 
warrant uninterrupted or error-free operation of the product.

THERE ARE NO EXPRESS WARRANTIES OTHER THAN THOSE LISTED AND DESCRIBED ABOVE, AND NO 
WARRANTIES WHETHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, SHALL APPLY AFTER THE EXPRESS WARRANTY 
PERIODS STATED ABOVE, AND NO OTHER EXPRESS WARRANTY OR GUARANTY GIVEN BY ANY PERSON, FIRM OR 
CORPORATION WITH RESPECT TO THIS PRODUCT SHALL BE BINDING ON SAMSUNG. SAMSUNG SHALL NOT BE 
LIABLE FOR LOSS OF REVENUE OR PROFITS, FAILURE TO REALIZE SAVINGS OR OTHER BENEFITS, OR ANY OTHER 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES CAUSED BY THE USE, MISUSE OR INABILITY TO USE 
THIS PRODUCT, REGARDLESS OF THE LEGAL THEORY ON WHICH THE CLAIM IS BASED, AND EVEN IF SAMSUNG 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. NOR SHALL RECOVERY OF ANY KIND AGAINST 
SAMSUNG BE GREATER IN AMOUNT THAN THE PURCHASE PRICE OF THE PRODUCT SOLD BY SAMSUNG AND 
CAUSING THE ALLEGED DAMAGE. WITHOUT LIMITING THE FOREGOING, PURCHASER ASSUMES ALL RISK AND 
LIABILITY FOR LOSS, DAMAGE OR INJURY TO PURCHASER AND PURCHASER'S PROPERTY AND TO OTHERS AND 
THEIR PROPERTY ARISING OUT OF THE USE, MISUSE OR INABILITY TO USE THIS PRODUCT SOLD BY SAMSUNG 
NOT CAUSED DIRECTLY BY THE NEGLIGENCE OF SAMSUNG. THIS LIMITED WARRANTY SHALL NOT EXTEND TO 
ANYONE OTHER THAN THE ORIGINAL PURCHASER OF THIS PRODUCT, IS NONTRANSFERABLE AND STATES YOUR 
EXCLUSIVE REMEDY.

Some states do not allow limitations on how long an implied warranty lasts, or the exclusion or limitation of incidental or 
consequential damages, so the above limitations or exclusions may not apply to you. This warranty gives you specific legal 
rights, and you may also have other rights which vary from state to state.

To obtain warranty service, please contact SAMSUNG customer care center.
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QUESTIONS OR COMMENTS?
Area CALL OR VISIT US ONLINE AT WRITE

IN THE US 1-800-SAMSUNG
(726-7864) www.samsung.com/us

Samsung Electronics America, Inc.  
85 Challenger Road Ridgefield Park,  

NJ 07660
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